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1.01 [bookmark: 1.01_System_requirements_and_product_det][bookmark: _Toc205893253]System requirements and product details

	System requirements
	Windows XP, Vista, 7, 8, 10 and Windows 11. For Mac OS X, a Windows emulator is required

	License
	One-time purchase, unlimited use per computer

	Delivery
	Registration key via email

	Supported embossers
	Index (V2, V3, V4 and V5), ViewPlus (all models), Enabling (all models), PageBlaster (APH), Elotype, Gemini, Mountbatten Brailler.

	Available languages
	Arabic, Chinese, Czech, Danish, Dutch, English, French, German, Hindi, Italian, Japense, Korean, Norwegian, Polish, Portuguese, Russian, Spanish, Swedish, Turkish

	File formats
	TactileView file (.bpx) PDF and PRN; import .txt, .svg, .jpg, .png, .bmp, .tiff or .gif

	Internet requirements
	TactileView can be used offline, but specific functions (e.g map maker, designs catalog require internet access

	Software security
	A registration key is valid for software registration on one computer only. 



1.02 [bookmark: 1.02_Downloading_TactileView][bookmark: _Toc205893254]Downloading TactileView
The TactileView software is available for download and installation on Windows computers.

The software is compatible with Windows XP, Windows 7, 8, 10 and 11. For use with other operating systems, you will need a Windows emulator (such as Boot Camp or Parallels for Mac OS X).

Free trial

The software can be launched in demonstration mode without registration. All features are available. However, files cannot be saved, and prints will contain watermarks. To run the software in full version, you need a software product code (SPC). You can purchase a software product code (SPC) on the HumanWare product page.

Download

Click here to visit the download page in case you have not yet downloaded the software.[image: ]


Please note that administrator rights are required to install the software on your computer.

1.03 [bookmark: 1.03_Installing_software_(first_time)][bookmark: _Toc205893255]Installing software (first time)
To install the software after downloading, launch the TactileView installer from the USB drive or download folder. Follow the on-screen prompts to complete the installation. On the last screen, choose 'Finish', then launch the software from the Start menu.

Show installation steps
[image: Screenshot of the dialogue when starting the TactileView installation. Gives information on the copyright. Clicking the next button will proceed to the next steps.  ]

Step 1: Software details. Click 'Next' to proceed.


[image: ]

Step 2: Installation options. Select the folder in which TactileView will be installed if necessary and click 'Install' to proceed.


[image: Screenshot of the progress bar. ]

Step 3: TactileView installation. This will be completed automatically.
[image: ]

Step 4: Installation has finished. Click 'Finish' to close the installer.







First launch

During the first launch, you will be prompted to select your user language. Choose your preferred language from the list and click "OK" to confirm. Please note that some of these user languages have been automatically translated and may not be entirely accurate.
Show language selection
[image: Screenshot of the language selector when first opening TactileView. ]

Set user language when launching TactileView for the first time.













[bookmark: _Configuration_wizard]Configuration wizard
TactileView will now open and prompt you with the Configuration Wizard, which will guide you through registration and the most important settings for optimal use of the software. Each of the 4 steps in the configuration wizard are 'Computer registration', 'Printer setup', 'Configuration' and 'External software'. In each step, there is a list with the essential settings. By selecting one from this list, you can read the description on the right. Click on 'Open selected option' to go to the selected settings dialog.

[image: Screenshot of the welcome dialogue with the option to select configuration wizard or to skip]

Configuration wizard: Introduction. This window gives an overview of the different steps in the configuration wizard. Click on 'Start configuration wizard' to proceed.


[image: Screenshot of step 1/4 - Computer registration. Two options are available:
- Registration via internet
-Registration via distributer]

Configuration wizard step 1/4: Computer registration. In this step, you can register your software license.
[image: Screenshot of step 2/4 - Printer setup. ]

Configuration wizard step 2/4: Printer setup. This second step will help you to configure the steps required for printing your tactile designs.


[image: Screenshot of step 3/4 - Configuration]

Configuration wizard step 3/4: Language and texts. All basic settings for operating the software are included in this third step.
[image: Screenshot of step 4/4 - External software. Two available options include:
- Inert tactileview design in text file
- Mathematical notation (equation editor)]

Configuration wizard step 4/4: External software. This final step will help you to extend the functionality of TactileView with external software.


1.04 [bookmark: 1.04_Updates_and_beta_versions][bookmark: 1.05_Transfer_installation_or_uninstall_][bookmark: _Toc205893256]Transfer installation or uninstall TactileView
The software product code (SPC) enables the software to run on a single computer. If you need to use the full version of the software on another computer, an additional SPC will be required.
Visit our shop to purchase an extra software license.

Reinstalling on another computer

You may wish to transfer the software installation to a different computer using the same SPC. By sending us an email, we can remove the current computer's registration data, enabling the SPC to be reinstalled on another system. A confirmation email will be sent to the email address provided during registration.

Uninstall TactileView

If you wish to uninstall the software from the current computer, open the Control Panel, click 'Programs', then select 'Programs and Features'. Select TactileView from the list and click 'Uninstall'.

1.05 [bookmark: 1.06_Troubleshooting][bookmark: _Toc205893257]Troubleshooting
TactileView software has been in use for over a decade and is entirely safe to use. However, due to its limited user base, some virus scanners, web browsers, and versions of Windows may automatically block TactileView. Below are a few methods to resolve the most common issues encountered when downloading and installing the software.

Downloading the software - browsers

Some browsers might block a downloaded file when it is not downloaded regularly. Google Chrome
[image: Screenshot of some browsers security alert when attempting to download Tactileview]After downloading TactileView, Google Chrome might block launching the downloaded file.


This is encountered mostly with new releases or development versions of TactileView. Click on the small arrow on the right to show more options, then choose 'Keep' to dismiss this message.







Internet Explorer

When the security level in Internet Explorer is set to 'High', a message will appear when you download TactileView.
[image: A screenshot of a security dialogue. ]

To solve this, click on the gear icon in the top right corner and go to Internet Options. In the Security tab, reduce the security level to 'Medium-high'. You can now retry downloading the software installer. Next, choose to save or run the TactileView installer.







Other browsers

In case another web browser blocks your downloaded file, check the security settings of the browser or any virus scanner add-ons. If these are too strict, try to lower the security level and retry to download the file.







Installing the software

Windows SmartScreen
[image: Screenshot of a protection dialogue when attempting to download TactileView]

Windows SmartScreen will often block when the TactileView installer is launched for the first time.


[image: Screenshot of windows protection with two options, Run anyway and don't run. ]

To continue with the installation, click on 'More info', then select 'Run anyway'.







Virus scanners

As with browsers, the security level of your virus scanner will determine whether launching TactileView will be allowed. Lowering the security level will usually solve the problem. The example below shows how to resolve the problem when a lower security level will still block TactileView. In this example AVG is shown, but other virus scanners will provide similar options.


[image: Screenshot of the AVG Free antivirus with the advance settings selected]

1. Go to 'Options' and select 'Advanced settings'.


[image: Screenshot of the AVG Free antivirus with the exceptions dialogue selected. ]

2. From the list of options, select 'Exceptions' and click on 'Add exception'.


[image: Screenshot of AVG Antivirus with a dropdown selection of exceptions. ]

3. Select 'Application or File' as Exception type.


[image: Screenshot of AVG Antivirus with various check boxes once an exception type is selected.]

4. In the list of options that appears, browse to the location of the TactileView executable file; by default this will be C:\Program Files (x86)\TactileView\TactileV.exe. Check 'Even when the file has been changed or updated' to avoid having to repeat this process after a software update. Click 'OK' to confirm.


[image: Screenshot of AVG Antivirus showing the exceptions added]

5. You will now see TactileView in the list of exceptions. You need administrator rights to confirm the changes by clicking 'OK'.

2.01 [bookmark: 2.01_Software_product_code_(software_lic][bookmark: _Toc205893258]Software product code (software license)
To run the full version of the software, you need a software product code (SPC). When you make a purchase, you will receive a license number, which is also referred to as an SPC. This license number will be sent to you via email.

Click here to purchase a license for TactileView.

Software registration

You can follow the configuration wizard to register your software license. This will start automatically after launching TactileView the first time. If you wish to register at a later stage, you can select the configuration wizard from the Help menu, or select 'Computer registration' from the Settings menu.

Step 1 of the configuration wizard will guide you through the software registration. Choose 'Registration via internet' to register the software online with your SPC. When the computer on which you want to register the software does not have internet access, you can choose 'Registration via dealer'. After registration, the other three steps in the configuration wizard will help you to prepare and personalize the software for optimal use.

Registration via internet
In the dialog that appears, enter your name and SPC, then click OK. Your name, SPC, and the computer identification code will be stored on the TactileView website to finalize the registration. An SPC can be used to register TactileView on only one computer. To register the software for all users on the computer, you will need administrator rights.
2.02 [bookmark: 2.02_Using_the_free_demonstration_mode][bookmark: _Toc205893259]Using the free demonstration mode
For a free trial version of the software, you can simply download TactileView for free and install it on your computer (requires administrator rights). This allows you to use the software in demonstration mode without registration and to explore the great features in the software for creating tactile graphics. In demonstration mode, all software features are available. The only restrictions will be that printed designs will contain watermarks and files cannot be saved.
[image: ]


To download the free trial version of TactileView, click here.

Configuration for demonstration mode
After launching the software for the first time, the configuration wizard will automatically guide you through the most important settings. To start using TactileView in demonstration mode, you can skip step 1 of 4 in the wizard. We strongly advise you to take the time to go through the remaining three steps, which present you with the settings that will give you the optimal user experience. You can revisit these and other setting via the Settings menu.

Read more about the Configuration wizard > Configuration wizard

Upgrading to a full software version
After exploring the software, we hope you enjoy it enough to reach out to one of our dealers or purchase your license directly from the HumanWare store.

2.03 [bookmark: 2.03_Settings_menu][bookmark: _Toc205893260]Settings menu
 [image: ]
The configuration wizard leads you through the initial steps for setting up the software to accommodate your needs. However, additional options/dialogs can be found in the Settings menu. In this menu, all the different settings of the software can be found, including those that are part of the configuration wizard.

Most option names should be self-explanatory. Each settings dialog includes an introductory explanation that will assist you in choosing the most suitable configuration. The list below provides an overview of the functionality of each option in the Settings menu and offers a general description of the purpose of each menu item.

Computer registration

This item is only available if running in demo mode. The software product code (SPC) has to be entered in the registration window. After selecting ‘Registration via internet’, your registration data will be checked on the TactileView website to verify the validity of the registration. Please note that each SPC is valid for only one computer.

Configuration wizard: step 1

General

The units for the preferred measurement system can be set, as well as the reference position for these measurements. The size of the markers that can be ‘grabbed’ with the mouse to modify objects can be adjusted. A marker size of 5 pixels is the default.

The internet gateway to the TactileView internet catalog can be tested and configured. The name and e- mail address of the author that is uploading designs to the catalog can be entered here. The TactileView Viewmaster will send feedback on the graphic aspects and tactile usability of the designs to this e-mail address.

Configuration wizard: step 3

Languages

The user language in which the software texts are displayed can be set, as well as the language in which the text labels are written in the design. Setting the text label correct language is important for uploading the designs to the catalog, as text labels are translated in all the available languages.

Configuration wizard: step 3

Keyboard Shortcuts

This section outlines all the available keyboard shortcuts in TactileView. It is also possible to customize the list of shortcuts to suit your preferences by double clicking on the shortcut you wish to edit. 

Braille tables

The conventions for braille text vary by country or language. To set the main braille format, select a braille table from the extended list of the Liblouis table set (which includes contracted braille). When entering a text label in the design using the "Add text label" drawing tool, the braille characters will be automatically generated based on the selected braille table.

Configuration wizard: step 2

Sign up for newsletter

The Humanware newsletter is a resource in which we announce events and share ideas about the usage of TactileView and various other products by Humanware. Our regular newsletter is a great way to stay in touch with our work and everything that's going on at Humanware, so we invite you to sign up and leave your feedback.

Configuration wizard: step 3

Update TactileView components

Technically the software is set up as a modular system. The various modules, such as the software texts that you find in menus and dialogs, are stored and maintained on a non-public section of the TactileView website. TactileView will download any new updates automatically each time the software is launched. This setup offers great flexibility and convenience to provide minor updates without requiring any action, so it is advised to have this setting switched on. Please note that an internet connection is required to receive updates.

Configuration wizard: step 3

Pop-up Messages
In some cases, TactileView may display a pop-up dialogue. This option allows you to restore any pop-up messages that you have previously marked as "Don’t Show."

Text label presentation: on screen

The appearance of braille is quite different from the standard font and is hard to read for sighted users. Therefore the text that is added as a text label in the design can be displayed in standard font as well as in the equivalent braille characters, based on the selected braille table. The colour of the standard font (default green) can be changed or can be switched off completely.

Configuration wizard: step 3

Text label presentation: on print

Text labels printed on swellpaper can be represented both in braille and standard font, similar to the display on screen. The braille dots are printed in black. The visual font can be switched off or set to any preferred colour. For printing on swellpaper, make sure that the selected colour has no grey or black appearance.

Configuration wizard: step 2

Alignment Frame Settings

The Alignment frame can be activated as a guide to restrict the design to a specific area within the printable region of a page. This section enables you to customize braille spacing, align text, and adjust the units of measurement.

Mathematical notation (equation editor)

The MathType equation editor can be used to prepare mathematical equations in their spatial layout. The mathML expression is copied/pasted into TactileView. The equation can be expressed in braille using several mathematical notations. The preferred math notation is selected here.

Configuration wizard: step 4

Insert TactileView design in text file

TactileView designs can be embedded in documents produced with the Duxbury Braille Translator (DBT). For more details, see the section on third-party software.

Configuration wizard: step 4

Figures

Arrows, electrical or chemical symbols, smileys, etc. can be added to the design as a figure by selecting the drawing tool ‘Add Figure’. A library of figures is included, but new categories or figures can be added. In this settings dialog you can set the folder for your personal library of figures.

Speech

The Text-to-Speech engine (TTS) is selected in this dialog and performs two tasks.

The TTS vocalizes the software messages to support the use of a screen reader and is announcing the text that is supplied in the audio style for an object.

A design, once embossed, is called tactile diagram. In addition to the tactile information, an extra layer of audio information can be added to the design. Specific areas can be provided with an audio style (See also common properties of objects). The TTS is used for when exploring the audible information in a diagram.


Microphone

The built in microphone or an external one can be configured for adding recordings as an audio style to an object. See: Common properties of objects.

Touch tablet

A touch tablet can be connected to explore audio tactile diagrams. The settings are configured in this settings dialog. See also the section ‘Audio tactile diagrams’.


3.01 [bookmark: 3.01_Software_window_elements][bookmark: _Toc205893261]Software window elements
After launching TactileView, the software window will contain the following sections that provide all available functionality and allow you to operate all the functions in the software.

Drawing area

The drawing area of the design is located in the centre of the TactileView window. It is surrounded by a red border, which indicates the size of the printable area on the selected paper size for the selected printer. Some printers have larger margins along the edges of the paper that cannot be printed, resulting in a smaller area within the red border compared to other printers.
The white area shows the actual size of the contents of your design, this is also known as the canvas. The size of the contents can be increased in size both horizontally and vertically to span multiple pages. If the white area does not fit within the red border of the printable area, you can reduce the size to make it fit within the page(s). All software functions are situated around this drawing area.
 [image: ]
Figure 1. Drawing area highlighted in green.



Top section: menus and horizontal icon bars

Above the drawing area, you'll find two key elements: the software menus and a horizontal icon bar displaying the names of open documents in tab form. The row of icons provides quick access to commonly used functions, many of which are directly related to the design you're working on. Most icons visually represent their function, and if you hover your mouse over one, a tooltip will appear in your selected language, explaining what the icon does when clicked.

 [image: ]
Figure 2. Menus and horizontal icon bars highlighted in green.












Left section: vertical icon bars
On the left-hand side, you can find three vertical icon bars. The leftmost vertical icon bar contains all the drawing tools to create graphics or modify the content of your design. By selecting one of these tools and clicking in the drawing area, different objects can be placed.
The right vertical icon bar will show the range of properties for the current selection. This can either be the drawing tool selected from the left toolbar or the object in the design that has the focus. You can (re)select an object by clicking on it in the design area.
Once again, tooltips will explain which functions are represented by the icons in the vertical toolbars.
 [image: ]
Figure 3. Vertical icon bars highlighted in green.



Bottom section: status line

Below the drawing area you will find the status line, showing mouse position, dimensions, etc. for the selected drawing tool or object in the design.


 [image: ]
Figure 4. Drawing area highlighted in green.



3.02 [bookmark: 3.02_After_launching_the_software][bookmark: _Toc205893262]After launching the software
In this section you can find a first introduction to some of the first software functions you will come across when you create a tactile design.

First impression

Once you launch the software, a red border will indicate the current paper size and orientation.

In the top left corner, you'll see the word "Title". This serves as a reminder of the importance of including a title in your design, as it helps readers quickly understand the content of the diagram. You can customize or remove the title through the Design Elements options.

When starting a new design, a tactile marker will appear in the upper right corner of the screen. This is known as the right-up marker, and it's designed to help blind users determine the correct paper orientation without needing to examine the diagram. Regardless of whether the layout is portrait or landscape, this marker always appears in the top-right corner. On-screen, it's represented by three blue lines angled at 45 degrees.

For most projects, it's recommended to keep the right-up marker enabled to improve accessibility. However, you can toggle it on or off by clicking the Toggle Right-Up Marker icon on the horizontal toolbar




 [image: ]


Figure 1. The top of the design shows the title text label, right-up marker and red border for paper size and orientation.

Design orientation: landscape or portrait designs

Choosing the right paper orientation for your design allows you to use the available space on the paper. This way, the image can be presented as large as possible to retain smaller details. You can change the paper orientation by clicking on the design menu item, then select 'Change the orientation to landscape/portrait'.

It is important to know that changing the paper orientation will not adjust the size of the image! This ensures that the image's tactile quality is maintained. However, you might need to manually adjust the width and/or height to fit the new paper orientation by dragging the markers around the design.





Portrait to landscape orientation

If you start your design with a tree in portrait mode and later decide to switch to landscape, you can easily change the paper orientation. However, note that the size of the white design area containing the tree will remain the same.

After switching to landscape, it’s likely that the lower part of your design will extend beyond the red border, and your design may now span two sheets of paper instead of one. While the software allows designs to spread over multiple pages, it’s best practice to resize your design to fit a single sheet whenever possible.

To adjust the height of the tree, use the blue marker in the lower right corner of the design area. This allows you to scale the tree so that it fits within the page boundaries. Keep in mind that reducing the size may affect the readability of small details, especially for tactile use, so be sure all elements remain clear and usable.

Once the height is adjusted, use the purple marker located in the middle of the right edge to extend the width of the design to match the new paper orientation.


Landscape to portrait orientation

The other way around, you might start with a tree that spans the height of a design in landscape orientation, but decide you want it to be in portrait to make better use of the length of the paper. In that case, you could increase the size of the image by using the blue marker in the lower right corner. You can use the purple markers in the middle of the two sides of the white area to trim any empty space left and right of the tree.

Line view and Dot view

To get familiar as soon as possible with the effect of creating designs for braille embossers, you can view the design on screen as it will be embossed in dots. This gives you a great advantage to see how the tactile graphic will appear without needing to necessary emboss. 

For good visibility you can use the line view mode for the drawing. When you switch to dot view, all lines will be converted to individual dots, just as your braille embosser will do. Note: The dot resolution will vary depending on the embosser you have selected. 

[image: A screenshot of a comparison between the line view and the dot view is side by side. ]

Figure 2. A circle shown in line view (left) or dot view (right) shows the graphic capabilities of the selected embosser.

3.03 [bookmark: 3.03_Colours_on_screen][bookmark: _Toc205893263]Colours on screen
General colour use in TactileView

[image: ] Green

The colour green is used as a colour for information. Everything you see in this colour by default is NOT printed on the design. Examples are: the font 'beneath' the braille dots of the textlabels, the alignment lines for the text labels, the grid for aligning object in the drawing area, the letters at the angles for the triangle.

[image: ] Blue

Objects created with one of the drawing tools (square, line, circle, dot, etc.) are presented in blue. Variations of blue are used to indicated the selected dot height (for embossers that support varying dot heights). A lighter blue colour indicates a lower dot height.

[image: ] Black

Lines that are created with the drawing tool 'Retouching: Adding lines', are drawn in black. This indicates that the line is part of the underlying bitmap in the design. The bitmap consists of individual pixels that can be erased by choosing 'Retouching: Erase'.

Any colours present in images inserted from file or from the internet will be converted to braille dots. These images should be processed using the filters and be converted to black/white in order to print them in braille lines.

[image: ] Purple

Markers are placed on or around a selected object. These markers can be used to reposition or resize the object, or change its proportions. Markers with a different function will have a different colour instead of purple.

[image: ] Red

A red border is surrounding the drawing area, reflecting the printable area of a sheet of paper in the selected paper size. When the designs exceeds this initial area, the red borders will signify that multiple sheets of paper will be printed that together will contain the design.

Special cases

Text labels

A rounded marker precedes each text label to signify the type of input used for the specific label.

[image: ] Green is used for text labels entered with the regular computer keyboard;

Orange for those that were created with Perkins style input;
Grey/blue for mathematical textlabels, created with the MathType equation editor.

Formulas in graphs

When multiple formulas are used in a graph, each formula in a graph will have its own colour (red, green, blue and yellow) to easily distinguish between them. These different colours are only used for display on the screen and will not lead to differences on a print.





[image: ]


Figure 1. Colours are used on screen to distinguish between different formulas.










Audio styles

Objects with audio styles are presented with a light red/pink fill.

[image: ]








Figure 3. The light red colour signifies that the circle contains an audio style.

3.04 [bookmark: 3.04_Portrait_or_landscape_design][bookmark: _Toc205893264]Portrait or landscape design
For tactile graphics, the image size has a big influence on tactile usability. TactileView provides several options to control both design and paper size for optimal tactile quality. 

Be aware that changes in paper orientation and scaling the design may unintentionally cause the edges of the design to extend beyond the size of one sheet of paper.


Amount of details in a tactile diagram
On one hand, the level of detail that can be presented in a tactile graphic is limited due to the discriminatory capabilities of the fingertips. On the other hand, the relatively large size of braille dots and the minimal required distance between dots also limit how much detail can be included.

The larger the design, the more detail can be retained when printed with an embosser or represented on a Monarch. This will help to control the complexity of the designs.
[image: ]

Figure 1. This image shows the shape of a fern branch, but might not contain sufficient tactile detail in the leaves. A separate image could be used to display leaf details.




Images as large as possible
Although there is a limitation to the size of an image when embossing, it is best practice to use as much of the paper as possible. Matching the design orientation to the dimensions of the tactile graphic (i.e. using landscape for wide images and portrait for higher ones) allows for optimal positioning on the paper. Rotating from landscape to portrait or vice versa may give a 30% larger image, which greatly improves the tactile usability.
[image: ]

Figure 2. By choosing the right orientation, the image can be shown larger, maintaining more detail.

When changing the design orientation, the image will not automatically be scaled. This way, as a designer, you have full control to determine the ideal dimensions of the tactile diagram.

Try to think about the optimal size of the tactile diagram before starting the design: a higher level of detail will require a larger design size. Adjustments in size can always be made later by scaling the design with the purple markers around the edge. However, text labels have a fixed size. By scaling the image they might overlap lines or may end up too far from the elements in the drawing that they refer to.

Multiple sheets of paper
The maximum size of paper that printers generally can handle is A4, A3, US Letter or Tabloid. However, diagrams can be larger than the maximum paper size when an image needs to be enlarged to retain the level of detail in the original image. Multiple sheets can be placed in rows and or columns to allow for tactile diagrams of any large size. The red paper border will indicate the size of the design and the number of sheets.

3.05 [bookmark: 3.05_Scroll_wheel_and_key_combinations][bookmark: _Toc205893265]Scroll wheel and key combinations
A number of software features are easily accessible by using the scroll wheel when operating the software with your mouse. The description below gives an overview of the different operations using the scroll wheel for better efficiency when drawing.

	Operation
	Shortcut

	Pan vertically through design
	Scroll up/down

	Zoom in
	Ctrl + scroll up

	Zoom out
	Ctrl + scroll down

	Rotate selected object 5 degrees
	Shift + scroll up/down

	Rotate selected object 1 degree
	Shift + alt + scroll up/down

	Increase/decrease line thickness
	Shift + scroll up/down

	Increase dot size
	Shift + scroll up/down





Pan vertically through the design (Scroll up/down)

When the mouse is in the design area, scrolling up or down with the mouse wheel (no keys pressed) will allow you to move vertically through the design.

Zooming in/out (Ctrl + scroll up/down)

To view a particular part of the design in more detail, you can zoom in by using Ctrl + scroll up. Ctrl + scroll down will zoom out in order to view a larger section of the design.

Rotation of objects (Shift + scroll, Shift + Ctrl + scroll)

Almost all objects (including text labels) can be rotated at any number of degrees. The angle for the rotation can be set in an edit field by clicking 'Rotation' in the object's toolbar. For easy access, a selected object can be rotated in steps of 5 degrees by using Shift + scroll wheel up/down. For more accuracy, Ctrl + shift
+ scroll up/down will rotate the object in steps of 1 degree.

Increase/decrease of line thickness or dot size (Shift + scroll up/down)

The value for the line thickness, the eraser width or the size of the blue dots can be set by entering a value in the respective dialogs. While drawing, the size can be easily adjusted Shift + scroll wheel.

3.06 [bookmark: 3.06_Layout_tools][bookmark: _Toc205893266]Layout tools
Several tools are available in TactileView to facilitate a precise design process and comply with regulations and conventions specifying the layout of a tactile diagram.

Right-up marker
Once the design is printed and in the hands of the reader, the right-up marker is a tactile marker in the top right corner. This right-up marker helps to find the correct orientation of the diagram without having to explore the tactile diagram itself. This way, you can easily find out if the design should be read in a portrait or landscape orientation.

When the marker is presented in blue on screen, it will be printed. By clicking on the marker icon on the top horizontal bar the right-up marker can be selected or unselected. 


 [image: ]


Figure 1. The right-up marker is shown on screen. 'Draw right-up marker' icon: [image: Icon of draw right marker ]
Alignment grid
A green grid can be displayed on the design area to help you align objects accurately. The grid can be customized to your preferred cell size, making it easier to position elements consistently. Please note that the grid is for visual alignment only and will not be printed with your design.

To show or hide the grid and adjust the cell size, click the 'Alignment Frame Display' icon in the horizontal toolbar. A selection of options will appear, choose 'Show Grid' to enable it.

Alternatively, you can access the same option through the View menu. 

[image: Screenshot of the grid lines]








Figure 2. The green dotted grid lines can be used for alignment. 
'Alignment frame display' icon:  [image: ]





Dot view / line view mode

Tactile graphic capabilities vary depending on the production method used. To optimize your design for different output devices, use the 'Design Mode: Dot View / Line View' option.

· Dot View displays the graphic according to the specific resolution of the selected embosser. This mode ensures that what you see on-screen closely matches how the tactile graphic will be printed.

· Line View offers a cleaner, simplified layout ideal for on-screen editing.

If Monarch mode is active, Dot View will still reflect the resolution settings used on Monarch.

Use this feature to ensure your design is correctly formatted for the chosen output device.

Text label alignment
For accurate placement of texts in your tactile graphics, text labels can be aligned horizontally or vertically with other labels in the design. You can select 'Switch text label alignment on/off' from the properties toolbar of a selected text label, or when placing a new label in the design.

[image: A screen shot of a graph

AI-generated content may be incorrect.]As long as the alignment function is on, green 'magnetic' dotted lines will appear when moving a text label close to the horizontal or vertical position of another label in the design. The text label on which the moved label will be aligned will be highlighted. When you let go of this position, the moved label will automatically 'snap' to this alignment. The same applies to placing a new text label in your design. Please note that aligned text labels are not 'connected' but can still be moved and edited separately.











Figure 3. Text label alignment with green dotted lines.


Centre object or text label
All objects available in the toolbar include a ‘Centre’ option in their properties toolbar. When this option is selected, the object will automatically move to the center of the page.

Keep in mind that if the paper width is changed after centering, the object will no longer remain centered and may need to be adjusted again.

To access an object’s properties:

Right-click on the object or text label, or

Select the object and open the properties from the right side of the vertical toolbar.
'Centre' icon: [image: Centre icon]



Move horizontally / vertically
By holding the shift key and dragging a selected object or text label, the movement will only be in a perfectly horizontal or vertical direction.


3.07 [bookmark: _Toc204334124][bookmark: _Toc204334545][bookmark: _Toc204334960][bookmark: _Toc204335301][bookmark: 3.07_Design_mode:_dot_view/line_view][bookmark: _Toc205893267]Design mode: dot view/line view

The graphic capabilities of tactile images vary depending on the production method used. For example, swell paper behaves differently from embossed graphics, and Monarch output has its own unique characteristics. Additionally, each braille printer produces dots with varying shapes, heights, and placement accuracy.
When designing, it's important to consider these differences to ensure the final tactile output is clear and effective for the intended production method.

'Design mode: dot view' in the horizontal toolbar is used to display the specific graphic properties of the selected output medium. With dot view selected, the dots are continuously repositioned to match the printed outputs as you add to your design. This functions like a 'live print preview' in which you can directly edit your design and see the final output at the same time.

If you want to see the line drawing that the embossed image is based on or that is printed on swellpaper, simply go back to 'Design mode: line view'.
 [image: A drawing of a shark

AI-generated content may be incorrect.]

Figure 1. The difference between displaying a design in line view (left) and dot view (right).

3.08 [bookmark: 3.08_Transparency_and_object_stacking][bookmark: _Toc205893268]Transparency and object stacking
All blue objects with the exception of lines have two components: the outline (e.g. the three sides of a triangle) and the object's surface (the area in between those three lines). The object's surface can be given a combination of different properties, such as textures, colours and transparency.

The transparency comes into play when two or more objects are (partly) overlapping. When the object is transparent, all blue parts of the objects 'below' it will be visible and included on the print. When the object is not transparent, (parts of) the object below will be covered.

Select 'Change to cover underlying image (is now transparent)' from the properties toolbar or context menu to make the object non-transparent. Vice versa, select 'Change to make the underlying image visible (is now not transparent)' to make the object transparent.





[image: ]


Figure 1. The circle on the left is transparent, revealing the square below; the circle on the right is non-transparent and covers the square.


'Make object transparent' icon, also known as colour fill:

'Make object non-transparent' icon, also known as colour fill:






Control overlap with Object Stacking
By default, the order in which the objects are placed in the design determines the stacking order, i.e. which object is 'on top' and will overlap the 'lower' object(s). Objects that were placed later will be on top of earlier placed objects.

You can easily get an overview of the stacking order of the objects in your design by selecting 'Drawing tools” from the file menu, then choosing 'Show object stacking. When this is activated, a dialog box will list the available objects in logical order.  The lowest numbers will be on top, e.g. object 1 will cover object 3 when it is not transparent.

If you want to reverse the object order, select the object that you wish to move below or on top of another object, then select 'To back' or 'To front' to move it below or on top of the other object(s) respectively.


[image: ]



Figure 2. The green and orange numbers show the stacking order of the circles and squares.



'To front' icon:

'To back' icon:

3.09 [bookmark: 3.09_Bitmap_and_object_drawing][bookmark: _Toc205893269]Bitmap and object drawing
Any design in TactileView contains two layers: one is the underlying bitmap layer, and the second contains the editable objects, figures and text labels that are placed 'on top' of the bitmap. Both layers will be visible on your prints, i.e. objects do not have to be fused in order to be printed.

Retouching

You can use the retouching tools (pen and eraser) to draw freehand lines or erase elements in the bitmap. Objects and figures are not affected by the retouching tools and need to be fused with the bitmap first to (partially) erase them. 

Fusing objects with the bitmap

Editable objects can be fused to a bitmap at any time. To fuse an object to the bitmap, select it and then choose the 'Fuse object with bitmap' icon from the context menu which will be located on the second vertical toolbar at the left side of the screen, or right-click it and choose 'Fuse object with bitmap' from the context menu. You can also use Ctrl+B as a shortcut for fusing an object.

The editing markers (purple and/or red squares around the object) will disappear and the object will turn black and no longer be editable. The object is now part of the bitmap layer in your design and can be edited with the retouching tools.

If you accidentally fuse an editable object to the bitmap, you can choose 'Undo' from the Edit menu, press Ctrl+Z or click the 'Undo' icon from the tool bar across the top of the screen to undo this action and retrieve the editable object.

Please note that when you apply one of the filters from the Filter menu, the selected filter will be applied to all objects. To prevent any objects from becoming non-editable, you can apply a filter locally to a specific area by using the context menu on the left vertical toolbar or by right-clicking an object to access its properties.


Converting a selected area to an object

Objects that are part of a fused bitmap appear in black, and it is not possible to select them. To convert a selected area to an editable object, choose the 'Select area' icon from the left vertical toolbar, or choose 'Select area' from the Drawing Tools menu. Then click and drag the mouse to select a rectangular area around the part of the bitmap you wish to turn into an object.

Once the area is selected, it will be surrounded by a black dashed rectangle. Right-click anywhere inside the selected area and choose 'Convert to figure', or click on the large red marker on one of the sides of the selection. The selected area is now converted to a figure, which may be edited in the same way as any other figure object (image).

3.010 [bookmark: _Toc205893270]Monarch Mode
TactileView now supports the creation of tactile graphics for dynamic tactile devices, such as the Monarch. For more details about Monarch, please visit www.humanware.com/Monarch.

When Monarch Mode is activated in TactileView, the software adjusts the dot resolution to match the Monarch display. This allows you to preview and optimize how your tactile graphics will appear on the Monarch itself, without the need to have a physical device.

Note: When Monarch Mode is enabled, Print and Braille Mode will be disabled.

All existing tactile graphics created in TactileView can also be viewed and used in Monarch Mode.

Activate Monarch Mode
Click the Monarch butterfly icon from the horizontal toolbar, alternatively, you can select print from the file menu and then select “Monarch mode”.

In the dialogue that appears, check the box to activate Monarch Mode.

Once activated, additional options will appear, including:

· Export to PDF settings

· Initial document size configuration

These tools help you tailor your design specifically for display on a Monarch device.

Monarch icon: [image: ]

[image: A screenshot of a computer

AI-generated content may be incorrect.]

Figure 1: The Monarch Mode dialogue, with a checkbox to enable/disable.

Export to PDF setting
Unlike traditional embossers, Monarch is not limited by standard page sizes, giving you greater flexibility when working with larger tactile graphics.





When exporting your design, you can choose to:

· Export document always as one page – This option allows you to create a large tactile graphic without dividing it into separate pages. Although TactileView may visually display page outlines when working with larger designs, the entire document will be treated as one continuous page for design and printing purposes.


· Export large document as multiple pages - useful for breaking down large documents.

For example, a graphic that spans two or more pages would typically require embossing each page separately and taping them together for a continuous layout. In contrast, Monarch can display the entire tactile graphic as one seamless page, even if the design would normally exceed standard paper dimensions.

This makes Monarch ideal for working with large or complex tactile designs without the need for manual assembly.

Initial document size 	
Although Monarch is not restricted by standard paper sizes, selecting a document size is still important, especially if you plan to export your design as multiple pages. Even when exporting as a single page, the page boundaries will still be highlighted to help guide layout and formatting. In one case it can provide a good level of understanding of how the Monarch user will view Tactile Graphics. 
Tip: Optimizing for Monarch Screen Size
If you want your tactile graphic to fit exactly within the Monarch display screen, choose “Monarch Screen” from the Initial Document Size dropdown menu. This ensures that the entire graphic is viewable on the screen without the need to pan. It may also be useful to have the Monarch screen size set when exporting as one page, so you can get an understanding of how a Monarch user would interact with and navigate through the tactile graphic.  
⚠️ Note: While this setting improves navigation, it may reduce the size of the graphic, potentially making fine details harder to interpret through touch. Be mindful of this trade-off when designing for clarity and accessibility.

Braille after ink printing 

Ink over braille refers to the practice of printing visual (ink) text or graphics directly above or alongside braille on the same document. This technique allows the same material to be read by both sighted users and braille readers, making it ideal for inclusive communication and education.
Key Benefits:
· Dual readability: Allows sighted individuals (e.g., teachers, parents, or peers) to read the same content as a braille user.
· Efficient communication: Supports collaborative learning, group activities, or shared documents in mixed-ability settings.
How It Works in TactileView:
When using TactileView, enabling Ink over braille ensures that:
· Printed (ink) text is automatically placed above or beside the corresponding braille label.
· Both versions remain aligned and do not interfere with each other’s readability.
· The layout remains clear for both tactile reading and visual inspection.
Note: Ink over braille is especially useful for educational materials, tactile diagrams, and inclusive printed documents. It can be toggled on or off depending on your output needs. In the event that the icon is no longer visible, check that Monarch mode is deactivated. 
Activate Braille After Ink
To activate this mode, select the Braille after ink icon, which can be found on the top horizontal toolbar. It can also be accessed from the Print file dialogue. 
[image: ] Braille after ink Icon. 



It’s recommended to run a calibration the first time you activate the device. The Calibration Wizard will guide you through several steps to ensure the ink and braille are properly aligned.

Once calibration is complete and you’re satisfied with the results, select the checkbox to enable Braille After Ink mode. For more details, see Using Braille After Ink.

[image: A screen shot of a computer

AI-generated content may be incorrect.]

Figure 1: Braille after ink dialogue, with a checkbox to enable/disable mode. 


Select your ink printer and braille embosser by choosing the relevant options. Ensure that both are set to use the same paper size - mismatched settings will trigger a warning message.

Select how you want braille after ink to work. There are two options available. 
· Print images in braille only and text with both braille and ink
· Print everything using braille and ink


Once both printers are configured correctly, click “Braille After Ink Calibration” to begin the calibration process.







Braille after ink calibration

[image: A screenshot of a computer

AI-generated content may be incorrect.]
Figure 2: Braille after ink calibration  


1. To begin the calibration, select the calibration wizard button.
2. As part of step 1 of the calibration, you will need to print a test page. Print both the ink and braille test page using the same sheet of paper. This will give the current calibration settings and will be required for the remaining calibration wizard. 

[image: A screenshot of a computer screen

AI-generated content may be incorrect.]
Figure 3: Step 1/7 of the calibration wizard. 



[image: A screenshot of a computer screen

AI-generated content may be incorrect.] 

Figure 4:  Print test page


Continue through the remaining steps in the wizard. If required, you will be prompted to enter the math positions for both braille and ink using the test print.

When you have completed all steps, select Finish to exit the wizard.


Using Braille after ink   


Once activated, new icons will be visible on the top horizontal bar. 


[image: ] Two icons representing the ink print. (Print ink and print ink preview)
[image: ]Two icons representing the braille print (Emboss and embossed preview)

It is recommended to select the Print Ink option first. Once the ink has been printed, place the same sheet of paper into the embosser, ensuring it is positioned in the correct orientation. Then select the Emboss icon.

If at any point the braille and ink are not aligned, you can adjust the settings manually or run the Calibration Wizard.


4.01 [bookmark: 4.01_The_7_ways_of_creating_a_design][bookmark: _Toc205893271]The 6 ways of creating a design
In TactileView, there are various ways of creating a tactile design, depending on the type of content you wish to create. For certain types of designs, specialized modules have been included in the software.
All 6 methods described below can be combined whenever needed in your designs.

1. Use premade designs from the TactileView catalogue
The TactileView catalogue contains thousands of premade designs, ready to be printed and used. Designers like you have uploaded the tactually usable designs they created. You can search for a particular design that you want to use, download it and make modifications needed before you produce it.
You can visit the TactileView designs catalogue by selecting 'Download and edit design from catalogue' from the Portal menu, or by clicking on the catalogue icon in the top menu bar.

2. Convert images from the internet
On the internet you can find an almost endless amount of images, many of which are suitable for production as tactile graphics. For some images only a minimum of effort is needed to adapt the image. By selecting the right image as a source, such as a line drawing instead of a more complex photo, a simple combination of applying filters and minimal use of retouching tools can be sufficient.

3. [bookmark: _Toc204334140][bookmark: _Toc204334561][bookmark: _Toc204334976][bookmark: _Toc204334141][bookmark: _Toc204334562][bookmark: _Toc204334977][bookmark: _Toc204334142][bookmark: _Toc204334563][bookmark: _Toc204334978]Create a design from scratch
With the series of drawing tools in the left vertical toolbar, a design can be partially or completely drawn from scratch in a blank design. This method often requires a little more effort than the previous three, but it gives the most flexibility in case no suitable images are available as a basis for your design.
Most designs require a combination of different drawing tools. The objects (indicated in blue) for example, give great precision and access to convenient properties such as textures. Text in the correct braille table can be added anywhere in the design as clarification. Special symbols can easily be added from the figures library.

4. Create graphs based on an equation
Graphs are widely used in mathematics and many other subjects, but there are a lot of factors that determine the tactile usability of a graph. The mathematics module in TactileView will help you to easily create a graph based on any given equation. This module can be accessed by selecting the Graphs menu or the Graphs icon in the left toolbar.

5. Create tactile maps
Producing maps of an area of any size (part of a city, region, country or even a continent) can be done with the map maker module in TactileView. Select 'Compose map' from the Portal menu, or click the map icon in the top toolbar.
The maps are composed on the RouteTactile website by selecting the area you wish to include in the map

or which features (streets, rivers, buildings, etc.) should be included. Keep in mind that including more elements will increase the complexity of the map.

6. Combine text and graphics in one document
Texts can be included in TactileView documents, but for some purposes, it is required to have a document where the graphics are part of a text book. The graphics can then be inserted in a braille editor such as Duxbury Braille Translator (DBT).
This can be achieved by saving the tactile graphic as a .bpx,then selecting Add picture from within Duxbury. 
4.02 [bookmark: 4.02_Creating_and_opening_files][bookmark: _Toc205893272]Creating and opening files
TactileView offers a number of different ways to begin making great tactile materials. You can create a file from scratch or start from a picture on your computer. Or you could get a head start by beginning from a pre-installed example file or one of the thousands of designs available in the online catalog.

1. Creating a new file

When you launch TactileView, a blank document opens automatically, so you can start working right away.

To create a new document at any time:
· Go to the File menu and select New
· Press Ctrl + N on your keyboard
· Or click the New Document icon on the horizontal toolbar

New document icon: [image: ]


2. [bookmark: _Toc204334149][bookmark: _Toc204334570][bookmark: _Toc204334985][bookmark: _Toc204334150][bookmark: _Toc204334571][bookmark: _Toc204334986][bookmark: _Toc204334151][bookmark: _Toc204334572][bookmark: _Toc204334987]Creating a new file by importing a picture

You can create a new document from a picture saved on your computer. To import a picture into TactileView, select 'Open' from the File menu or press Ctrl+O. In the Open dialog, browse to the location where your picture is stored and select it, then choose 'Open'. A new TactileView document containing the picture will be created.

Open icon: [image: ]

3. [bookmark: _Toc204334153][bookmark: _Toc204334574][bookmark: _Toc204334989][bookmark: _Toc204334154][bookmark: _Toc204334575][bookmark: _Toc204334990][bookmark: _Toc204334155][bookmark: _Toc204334576][bookmark: _Toc204334991][bookmark: _Toc204334156][bookmark: _Toc204334577][bookmark: _Toc204334992][bookmark: _Toc204334157][bookmark: _Toc204334578][bookmark: _Toc204334993]Opening a pre-installed example file

A number of example files are installed with the TactileView software. To open one of these files, select the 'Open TactileView Examples' option from the File menu. A dialog box will appear with a list of available sample files. Select a file from the list, then choose the 'Open' button to open it in TactileView.

Open TactileView examples icon: [image: ]


4. Downloading and opening a file from the online catalog

To download an existing file from the online catalog, open the Portal menu and choose 'Download and  Edit Design from Catalog'. This will launch a new window that will allow you to browse available files by category or search for something specific using the search field. Browsing by category is recommended for best results because of the variety of languages used for file titles and keywords.

Once you’ve chosen a category, select a design and choose the 'Closer Look' link (green arrow button) beneath it. This will launch a web browser window with a larger preview of the image in the file. Select the 'Download & Edit' link.

A dialog will pop up asking if you want to open or save the file. Select 'Open'.


NOTE:
If this is the first time you are downloading a file from the TactileView catalog, Windows may open a dialog box asking what application to use to open the .bpx file. Choose the option that allows you to browse your computer for the desired application, and browse to C:\Program Files\TactileView\TactileV.exe on a 32-bit operating system or C:\Program Files (x86)\TactileView\TactileV.exe on a 64-bit operating system. If there is a checkbox available to always use this program to open this type of file, make sure it is checked, then select the 'OK' button.

The file will now open in TactileView.
Download and edit design from TactileView Catalog icon: [image: ]


4.03 [bookmark: 4.03_Changing_design_orientation_and_siz][bookmark: _Toc205893273]Changing design orientation and size
In TactileView, the 'design size' refers to the size of the drawing area, represented on the screen by a white rectangle. The design size might not always match the paper size and orientation you are using (indicated by a red rectangle or rectangles on screen), especially if you are working on a design downloaded from the catalog or a file created by importing a jpeg or other image file.

By default, when you create a new file, the design area is sized and oriented to match the paper size and orientation currently set in your print setup. For example, if A4 paper in portrait orientation is set in your print setup, the design area in new files you create in TactileView will be created with this size and orientation.

Changing the design orientation

If the design size and orientation are not set to what you want to use, it’s best to change them prior to beginning to work on the file. To change the orientation of the design area, open the Design menu. If your design is currently set to portrait orientation, the first item in the menu will be 'Change Orientation to Landscape'. If your design is currently set to landscape orientation, the first item in the menu will be 'Change Orientation to Portrait'. Select this first menu item to change the orientation of the design. You can find the same option in the design properties toolbar (right vertical toolbar when no object or drawing tool is selected).

NOTE:
This option only changes the design orientation; if you wish to change the paper orientation for printing, you will need to change that separately (please refer to the Printing tutorial).

Resizing the design

The dimensions of the design area can be changed at any time. First, deselect any current drawing tool (press Esc) or object selection (Esc or by clicking on a blank space in the design area). Purple markers will appear around the outside of the design area. The markers adjust only the size of the design area. Click and drag a marker along the top or bottom edge vertically to increase or decrease the height of the design area, or click and drag a marker on the left or right edge horizontally to increase or decrease the width.

The square in the lower right corner of the design area is blue. The blue square lets you click and drag to scale the entire design area and its contents. This is useful when you’ve downloaded a file from the catalog and it’s not sized to fit the paper you’re using.

Scale design to paper size

When two or more red rectangles are visible, the design will be printed on more than one page. Click and drag the blue square at the lower right corner of the design area to scale the picture down until it fits on one page. You can also let TactileView scale the image down to one page for you by choosing 'Scale Picture to Paper Size Now' from the Edit menu.

Automatically scale pictures and downloaded designs

To allow TactileView to scale pictures automatically to fit the paper, you can choose 'Scale Pictures Automatically to Paper Size' from the Edit menu. This option will automatically scale the design area and picture to fit onto one page of the paper size currently selected in your print setup when you open a downloaded file or create a new file from a jpeg or other image file.

NOTE: When this option is selected, TactileView will also choose the design orientation that best fits the design area and picture, but it will not change the paper orientation in your print setup. Always ensure that your paper orientation matches the design orientation before embossing any file. You can verify this by checking if the design size (white area) and paper size (red borders) match.

4.04 [bookmark: 4.04_Importing_images_from_the_internet][bookmark: _Toc205893274]Importing images from the internet
Images from the internet often form a great source for a tactile image. The amount of different subjects that can be portrayed is virtually endless. However, selecting the right material from this vast resource can both improve the tactile quality and minimize the effort needed to convert the image into a tactile diagram.

Understanding which image works best

Virtually any image can be used as a basis for a tactile diagram, but some are more suitable than others. For example, some images are harder to understand when they converted to a tactile image. In general, a higher level of detail will result in a more difficult tactile diagram. Concepts such as shadows or three- dimensional perspective can be very hard to understand for a blind reader.

The second consideration is the amount of effort it takes to convert the image to a tactually usable design. Of course it depends greatly on the type of contents you wish to include in the image, but generally 'less is more': a simpler image takes less time to convert than a more detailed one.

An image needs to have enough features that can be understood by touch. This means that images often need to be simplified by isolating individual lines from the In most cases, line images are preferred as a basis for a design.
[image: ]

Figure 1. The image on the right has less fine detail and is less complex, making a tactile version easier to read and taking less effort to edit than the image on the left.

Make clever use Google image search

Using Google, you can search for images that match any keywords that you enter. In most cases this will give thousands of results, so in many cases you will need to refine your search criteria. You could try searching for a synonym or closely related word (e.g. 'trees' or 'woods' instead of 'forest'). If you speak

multiple languages it can be helpful to search for the same concept in another language.

Google also provides some tools to refine the type of image you are looking for. You can find these by clicking on the 'Search tools' button. These allow you to make some useful selections for finding the right material for tactile use. The most important selections for tactile use are:

· Size: larger images are generally better than smaller images, since they provide a better image quality in which more detail is retained when enlarged. You can also select 'Show sizes' under 'More tools' to get a quick overview of the image sizes.

· Type: refine the type of images that are presented. 'Line drawing' or 'Clip art' both are highly suitable as a basis for a tactile image, as they are often already simplified into individual lines and will be closer to what is required for a tactile image. We always advise to check first if these types of images are available to minimize the amount of effort it takes to create a tactile image.

The other search tools, such as colour and time can be used to further refine your search results. Appropriate usage rights can be selected if it concerns reproduction.
[image: ]

Figure 2. By making use of the Search Tools, you can select line drawings (right) instead of more complicated images, such as the photo on the left; the line drawing is much easier to read and edit.

Placing the image in your TactileView design

Once you have found a suitable image, right click on it to open the context menu, then select 'Copy image'. This will copy the image onto your clipboard. In TactileView, press Ctrl+V to paste the image in your design. This will place the image in the design area at the position of you mouse. You can also right click in an empty area of the design, then select 'Paste' to place the image on the position of the click. Or you can select 'Paste' from the Edit menu or click the 'Paste' icon in the top horizontal toolbar, which will place the image in the top left corner of the design.

If you have saved an image on your computer, you can choose 'Add figure' from the drawing tools icon bar, then select 'Import SVG' for svg image or 'Import image from file' for bitmap image (.jpg, .png, ...), or select 'Import image from file' from the File menu.

You can always resize or move the image to the required position in the design. Use the retouching tools (pen and eraser), a combination of the filters from the drawing tools toolbar or the Filters menu, or any of the other drawing tools to make the required adjustments to make the inserted image suitable for tactile use.
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Figure 3. Copying the image from your web browser.

4.05 [bookmark: 4.05_Importing_images_from_file_(.svg,_.][bookmark: _Toc205893275]Importing images from file (.svg, .png, .jpg, ...)
Saved images can be used as a basis for your tactile designs. These can be bitmap images (.bmp, .png,
.jpg, etc.) or SVG images. There are two ways to insert these files into your design.

Import image from file

To import a bitmap or SVG image file, select 'Add figure' from the drawing tools toolbar, then choose 'Import SVG' or 'Import image from file' from the context toolbar. A dialog will open in which you can browse and select the image file that you wish to use. Select 'image files' or 'svg files' as the type of file to limit the presented files to images suitable for importing. Once you have selected the correct image, click 'Open' to insert the image into your design. The chosen image is now inserted in the top left corner of the design.






'Add figure' icon:

'Import SVG' icon:
'Import image from file' icon: [image: ]






Copy from Windows File Explorer

In Windows File Explorer, select the image file that you wish to insert in your design. Right click on the file and select 'Copy', or use the shortcut Ctrl+C. In TactileView, position the mouse where you want to insert the file and press Ctrl+V to paste the image. Alternatively, you can also select 'Paste' from the Edit menu, the top horizontal toolbar or by opening the context menu by right clicking in the design and selecting 'Paste'.
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AI-generated content may be incorrect.]The leftmost vertical icon bar offers you several tools to add (graphic) objects, modify a selected area or apply a filter to the entire design. The tools are clustered into groups of similar drawing tools. There are two ways of composing your design: by modifying the bitmap and placing objects in the design.

Drawing tools: manipulating the bitmap
The retouching tools allow you to draw directly in the bitmap, where the lines you draw have a fixed position. 

The set of filters allows you to change colours or change the as an example the thickness of lines with filters. When you open a saved image file (e.g. a scanned image or an image saved from the internet) it needs to be fused with the bitmap in order to edit the image.

Drawing tools: placing objects
The list of available objects includes lines, squares, circles, triangles and dots, but also more complex objects such as tables and mathematical grids. These are represented in blue, indicating they are not 'fused with the bitmap' and can still be changed whenever you wish.
A special category of tools allows you to add text to the design: text labels, mammoth braille and drawing letters and digits. These tools will allow adding text in braille or regular font to highlight certain elements in the design.

Properties in the third vertical toolbar
Each tool has its own (second) vertical icon bar that will appear when you select a drawing tool or select the object (again) that was created with the tool. Most objects have some properties in common, such has position and size, whereas some other functions are specific for the tool or object.


5.02 [bookmark: _Toc204334227][bookmark: _Toc204334648][bookmark: _Toc204335063][bookmark: _Toc204335361][bookmark: _Toc204334228][bookmark: _Toc204334649][bookmark: _Toc204335064][bookmark: _Toc204335362][bookmark: 5.02_Common_properties_of_objects][bookmark: _Toc205893277]Common properties of objects
The drawing tools for placing objects, such as the ‘Draw Square-Rectangle’, allow you to place objects by clicking and dragging in the drawing area. The blue colour will indicate that an element in the design is an object. Below, you can find the common properties that are shared by most blue objects in TactileView.

Properties in right vertical icon bar
As soon as the drawing tool is activated in the left icon bar, or when the object is placed or is selected in the design, the properties icon bar for that selection will appear. For most objects, the first icon in this bar allows you to determine the size and position by entering the values via edit fields.

'Size and position' icon: [image: ]


Resizing and moving objects
Purple markers can be found on the corners and along the sides of the object. By pulling the markers on one of the four sides, you can adjust the width or height. For example, a square will become a rectangle. The markers in all four corners will scale the shape, maintaining the same aspect ratio.
You can move objects by holding the left mouse button and dragging it to another position, as indicated by the four-way arrow cursor. A green line will indicate the distance over which the object has moved. Two functions in the properties toolbar help you to move an object in a specific way: you can either choose to horizontally center it in the design, or only move it horizontally or vertically (alternative: hold shift while moving the object).
[image: ]Figure 1. Resizing a square using the purple markers.
[image: ]
Figure 2. The green line indicates the moved distance when moving an object with the mouse. 'Centre' icon: [image: ]
'Move horizontally or vertically' icon: [image: ]



Rotation
The object can rotate over 360 degrees. Scrolling with the mouse while holding down the Shift key will rotate per 5 degrees, or use Shift + Ctrl + mouse wheel for more accurate rotation per degree. You can also set the rotation to a certain value by choosing the 'Rotation' icon and entering the angle in the dialog that appears.



'Rotation' icon: [image: ]




Line style
The outer border of the object will be a solid line of a certain (narrow) thickness. The line style will allow for a variation in pattern, thickness and texture for the border. Choose 'Line style' from the properties toolbar, then select your style elements from the dialog.
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Figure 3. Squares with different line styles. 'Line style' icon: [image: ]

Surface properties part 1: add textures with Fill style
The Fill style will give you a wide variety of textures that add a tactile pattern in to the surface of the object. The pattern can be selected based on the preview. The patterns are made of repeated tiles. The tile size can be set to determine the fineness of the texture. The pattern can have its own rotation within the object, independent from the position and rotation of the object. This enables even more variation in textures, as the same texture can be used in various rotations, giving a different tactile experience.



[image: ]


Figure 4. Squares with different fill styles: no fill style (default) and diagonal lines. 'Fill style: texture' icon: [image: ]

Surface properties part 2: transparency
The transparency of an object determines whether or not it will cover underlying object. In case the object is transparent, only the border is visible. All parts of the design that are overlapped by the object are still visible.

In case the object is non transparent, all that is inside the object is covered by the white inner surface of the non-transparent object. Keep in mind that non-transparent objects might (completely) cover other elements in the design. You can change the order in which they are presented to determine which one is on top of the other.


'Make object transparent' icon:

'Make object non-transparent' icon:

Surface properties part 3: add colours for swellpaper
For production of the design on swellpaper, objects can have a colour as well. Select the desired colour from the dialog 'Fyll style: Colour'. Keep in mind that most embossers do not support printing in (coloured) ink, so this function does not apply to production with braille only.


'Fill style: colour' icon: [image: ]

Audio information
The 'Audio style' function is used to add audible information to an object, giving the object an extra 'layer' of information. This layer consists of a text that is pronounced by a speech synthesizer (TTS). This functionality is used to create an audio-tactile diagram and can be explored using the TactileView explore mode.

'Audio style' icon: [image: ]

Relief height
The relief height for the outline, surface and texture of objects can be selected separately. Keep in mind that this functionality is only available in the properties toolbar when using an embosser that supports variable dot height. The relief height for lines and textures can be changed through the line style and texture dialog respectively.



'Relief height: surface icons: [image: ]


Removing objects
You can delete the entire object by selecting 'Delete' in the properties toolbar or context menu, or by using the delete key. When you only want to remove parts of an object, you first have to fuse it with the bitmap. After this you can use the eraser tool to remove parts from the object.



'Delete icon: [image: ]







5.03 [bookmark: 5.03_Add_text_label][bookmark: _Toc205893278]Add text label
To read a tactile diagram with ease, it is often very helpful to add text information to certain parts of the design. For example the parts of a flower or rooms in a building can be labelled in the design.

Text label placement
To place a text label, click on the 'Add text label' icon in the drawing tools, then move the mouse to the desired position in the design and click again. You can start typing right away or use Ctrl+V to paste a copied text.
A text label can be positioned anywhere in the design. Leave enough space around texts labels to ensure the braille dots can be distinguished easily, so make sure that text label are not too close to lines in your design. This way you will maintain optimal tactile usability.



Add Text Label icon: [image: ]
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Figure 1. Click in the design to place a text label.





Precise placement: centre or align (snap)
Two functions in the options toolbar allow for more precise placement of text labels. The 'Centre' function will horizontally place the label in the middle of the design.
With 'Text label alignment' turned on, text labels can be aligned with previously placed labels. Green dotted lines appear in the design when placing or moving a label close to the vertical or horizontal position of other labels. The text label you are adding or moving will then snap to the green line.




Text label alignment icon:

Centre text label icon:

[image: ]

Figure 2. Text label alignment with green dotted lines.





Text label dimensions: using word wrap
The length of the text is not limited, so text labels can range from just a single number to multiple lines of text.
Initially the width is set to the maximum paper width. By dragging the sides of the text label you can determine the maximum width of the text (word wrap). Text that is exceeding the word wrap length is moved to the next line. The lines of braille text have a fixed height that matches the standardized height of embossed braille text.


[image: ]


Figure 3. Drag to determine the label's word wrap.
Text label presentation on screen
Text labels are displayed on screen using green print characters combined with black dots that represent the corresponding braille cells. This visual setup allows you to easily see both the printed text and the braille that will be embossed or printed on swell paper.
You can customize how text labels are shown by selecting ‘Text Label Presentation: On Screen’ from the toolbar or the context menu


Text label presentation on screen icon: [image: ]



Automatically correct braille: braille tables
The guidelines (so-called braille tables) for how texts are displayed in braille differ internationally. By selecting the correct default braille table via Settings > Braille Tables, the braille in your text labels will automatically be correct. This means that you do not need to have any knowledge of braille to get accurate braille in your designs. For example, braille composition signs for capital letters or numbers are automatically included.

White space behind labels (transparency)
By default, labels have a white space behind and around the braille text to ensure that other design elements do not interfere with the braille. Keep in mind that lines can be covered by the white space if the label is placed too close.
By switching off the white space (making the label transparent) you are able to place the text label on top of lines, but make sure they do not disturb the braille.
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Figure 4. Difference in text label transparency.













Types of text labels
There are three types of text labels based on different input methods for the text. Coloured markers before the labels indicate the label type. These are green for keyboard input, orange for Perkins style 8 dot braille input and blue-grey for mathematical equations. After selecting 'Add text label' from the drawing tools, you can select the type of text label in the right options toolbar.
Once a text label is placed in the design it is preceded by a round coloured marker. By hovering over the marker with the mouse, a tooltip will show extra information about the text label. A marker with a white centre indicates the label is transparent.



'Computer keyboard input' icon: 'Braille keyboard input' icon:
'Math input' icon: [image: ]

5.04 [bookmark: 5.04_Select_area;_editing_parts_of_the_d][bookmark: _Toc205893279]Select area; Editing parts of the design
The drawing tool 'Select area' enables you to manipulate a section of the design. After activating the tool, two types of functions become available: 'Select Rectangle' (default) and 'Insert or remove space'. The rectangular selection allows you to make localized adjustments to the contents of your design. Inserting or removing horizontal/vertical space is used to locally adjust the size of the drawing canvas.

Select rectangle - define the selection

After choosing 'Select area' from the drawing tools icon bar or Drawing tools menu, move the mouse into the drawing area and click to set the first position of the first corner. Next, move the cursor and click a second time to complete the selection. Alternatively, you can also click and hold for the first position, then move the cursor and release at the second position.

A dotted rectangle will indicate which area is selected. This selection can be adjusted by dragging the purple markers around the selection. To reposition the selection, move the cursor over the rectangle, then click and hold to drag the selection to another position.

Alternatively, you can select 'Size and position' from the properties toolbar or context menu to adjust the selection.

[image: ]


Figure 1. Selecting an area in the design. Select area icon: [image: ]

[image: ]Select rectangle icon:


Icons around the selection for easy access

A number of small icons along the edges of the selection give quick access to a few functions for editing the selected area.

Mirroring horizontally flips the selected image left to right, like turning a page in a book. Mirroring vertically flips the image upside down, like turning a page in a wall calendar.

Rotation and mirroring the area can be performed by simply clicking on the corresponding icons. The large red is used to move the selected area of the bitmap, whereas the blue marker allows you to move all objects and text labels that are (partially) within the selection.

The right vertical toolbar will show the full list of options for manipulating the selected section of the design.







[image: ][image: ]Rotate selection icons:


Mirror selection icons:


[image: ]Red marker for moving the bitmap:
Blue marker for moving objects:
[image: ]

Manipulate bitmap: crop, make selection white or fuse objects

To isolate the contents of the selected area from the rest of the design, select 'Crop Area'. Only the content will remain as the design, as the area outside the selection will be removed.

Select 'Paint Area White' to fill the selected part of the bitmap with white. Any objects in the selection will not be affected and have to be fused first to make them white. You can either fuse all objects within the selection by selecting 'Fuse the selected objects with the bitmap', or fuse objects individually by selecting and then fusing them.





Crop area icon: [image: ]
Paint area white icon: [image: ]






Edit selected area as figure (move and resize)

The selected area of the bitmap can be resized and moved by choosing 'Convert to figure (object)'. The purple markers around this figure can be used to resize the selection.

You can also choose 'Save as figure (file)' to save the figure to reuse it in other designs.





Save as figure (file) icon: [image: ] Convert to figure (object) icon: [image: ]

Apply filters

The selected content can be processed using the range of filters. These have the same functionality as the list of filters in the Filters menu, but will only be applied to the selection instead of the entire design.




[image: ]
Figure 2. Local adjustments by applying a filter to the selected area.





Adding/removing a vertical or horizontal area

The function ‘Selected strips’ can be used to remove the selected vertical or horizontal area, or to add this amount of white space to the design. To use this tool, activate 'Select area', then 'Insert or remove space'.

A crosshair cursor will appear when you move the mouse to the drawing area. By clicking once, the first outline of the selection is positioned, as indicated by the dotted green lines. Next, move the mouse horizontally or vertically and click a second time to complete the selection of the strip. Once again, you can also click and drag, then release at the second position to define the selection.

The width of the horizontal or vertical selection can be adjusted by dragging the purple marker on the green dotted lines.

A preview when hovering over the green plus sign will display the addition, whereas hovering over the red minus sign shows the design with the deleted area. Simply clicking on either sign will confirm the action.





[image: ]
Figure 3. Add or remove a horizontal or vertical area in the design. Insert or remove space icon: [image: ]

5.05 [bookmark: 5.05_Detect_shape][bookmark: _Toc205893280]Detect shape
The 'Detect shape' tool is used to add surface properties such as textures to selected parts of the design.

The 'Detect Shape' tool, as the name suggests, detects the shape of an area within the elements in the design. Select the 'Detect shape' tool from the left vertical toolbar, then click in the centre of the area in the design that you wish to edit. A red dotted line will indicate the contours of the detection.





'Detect shape' icon: [image: ]






Fine-tuning the selection

In some cases, the shape detection might need some fine-tuning to get the exact shape you need. You can use the purple markers to adjust the angular points of the shape, or click on one of the line segments to add another angular point.

In other cases, the detection may not be successful because the area is not fully enclosed by lines or other parts of the design. Small gaps cause other areas to be linked to the area you wish to detect.

You can compensate for small gaps by choosing 'Change shape detection criteria' from the toolbar or context menu. In the dialog that opens, you can readjust the levels for gap reduction. A higher will result in less gaps in the shape detection; however the detected shape will also have slightly more spacing around it.

You can apply shape detection to coloured images as well. In the detection criteria, you can adjust the range of colours that will be included in the shape around the detection position.

The detection criteria dialog contains a preview of the detected area, in which white signifies which area is part of the selection. Once you have adjusted the criteria, click 'Remove contour', then 'Apply detection' to improve the detected shape.

Add properties

When you are satisfied with the detected shape, you can add several properties to it, such as textures or an outline around the shape, just like any of the other (blue) objects.


5.06 [bookmark: 5.06_Filters;_editing_an_imported_image_][bookmark: _Toc205893281]Filters; editing an imported image (.jpg, .png, ...)
Images imported into TactileView need to be edited prior to printing using a combination of the filters and retouching tools. Because source images vary widely, it is helpful to experiment with the different filters to find out what works best for your image. If a filter does not produce the desired result, undo the action by selecting 'Undo' from the Edit menu or pressing CTRL+Z.
Filters can be applied in two ways: to all objects on the canvas at once, or to individual objects.
· To apply a filter to the entire canvas, go to the Filter option in the File menu, or click the Filter icon located in the first column of the left vertical toolbar.
· To apply filters to individual objects, use the context column, found in the third column of the left vertical toolbar. Selecting the filter icon will provide all available filter options specific to the selected object. Alternatively, right click on the object and select Show filters from the context menu. 
Show Filter icon: [image: ]
Once a filter has been activated a new window will appear with a horizontal slide bar to adjust the filter to your needs. When adjust the the slider, you will see in real time the image changing. Once set click saveWhen set, click on the ok button. 

You can activate one of the filters by selecting 'Filters' icon in the left vertical toolbar, or selecting one from the Filters menu. For some of the filters, a horizontal slider allows you to adjust the extent in which it is applied. The filters are applied to the entire design and will fuse all objects in the design.

You can also apply filters to a selected area only, without affecting the rest of the design.

Please note: The images on this page, the filters are only applied to the right- hand side of the image to show the effect compared to the original image on the left.


Convert to line drawing

One way to process the image so that it can better be embossed is to convert it to a line drawing. Select the Convert to Line Drawing option from the Filters menu. A new window will open with a slider bar to adjust the filter.  Drag the slider left or right until the image looks as desired.



[image: ]




Figure 1. 'Convert to line drawing' filter. 'Filter: convert to line drawing' icon: [image: ]

Convert to black and white

Some images can come out better when converted to black and white rather than to a line drawing. Select the Convert to Black and White option from the Filters menu. A new window will open with a slider bar to adjust the filter.  Drag the slider left or right until the image looks as desired.



[image: ]


Figure 2. 'Convert to black and white' filter. 'Filter: convert to black and white' icon: [image: ]


Change line thickness

Use this filter to increase or decrease line thicknesses in the image all at once. If your image contains a lot of light, thin lines or a dark, thick lines, this filter is helpful to make them all thicker or thinner at the same time. Select Change Line Thickness from the Filters menu. A new window will open with a slider bar to adjust the filter.  Slide it to the right to make lines thicker or to the left to make them thinner.






[image: ]


Figure 3. Thicker lines by applying the line thickness filter. 'Filter: change line thickness' icon: [image: ]




Add contours

This option allows you to add outlines around each different colored area in an image. Contours (black lines) are added at the transition point between one color and another and the thickness of the contour lines is controlled using the slider that appears at the upper left corner of the screen when you select the filter. This filter can be helpful for simple drawings that have well-defined areas in distinct colors, but is less useful when applied to photos or other images where color fades from lighter to darker without a distinct transition point.


[image: ]


Figure 4. 'Add contours' adds black contour lines to changes in colour in the image. 'Filter: add contours' icon: [image: ]
Blur image

The use of this filter lets you soften or sharpen edges between areas of color in an image. Select Blur the Image from the Filters menu, then use the slider that appears at the upper left corner of the screen to adjust the image. Sliding the slider right will soften edges and sliding it left will sharpen the edges.


[image: ]Figure 5. Right-hand side of the image is blurred with the 'Blur image' filter. 'Filter: blur image' icon: [image: ]







Replace colours

This filter is mostly used to remove certain colours in the image by converting them to white or black. In the dialog that appears, you can select which colour should be replaced from the list of colours that are present in the design. You can also adjust the colour range to include similar shades in the colour replacement. Once you are finished replacing the desired colours, click 'OK' to confirm the changes.

[image: ]


Figure 6. The red colour in the last olympic ring has been replaced by a dark purple colour. 'Filter: blur image' icon: [image: ]
Negative
This option is mostly used when an image has a lot of black area. Choosing Negative from the Filters menu will exchange all colors in the image file with their opposites. Black areas become white, blue areas become orange, red areas become green, etc.

[image: ]


Figure 7. 'Negative' filter applied to the right-hand side of the image. 'Filter: negative' icon: [image: ]
Rotating, mirroring and scaling the image

To rotate the entire image, select either 'Rotate Clockwise' or 'Rotate counterclockwise' from the Filters menu. The image will rotate 90 degrees in the direction you selected.

To mirror the image, select 'Mirror Horizontally' or 'Mirror Vertically' from the Filters menu. Mirroring horizontally flips the image left to right, like turning a page in a book. Mirroring vertically flips the image upside down, like turning a page in a wall calendar.

To scale the image, select it and then drag the blue square in the lower right corner of the design area diagonally to scale the image smaller or larger.


'Filter: rotate clockwise/anticlockwise' icons:

'Filter: mirror horizontally/vertically' icon: 'Filter: scale design' icon: [image: ]
'Filter: fuse all objects with bitmap' icon: [image: ]

5.07 [bookmark: 5.07_Retouching_tools;_pen_and_eraser][bookmark: _Toc205893282]Retouching tools; pen and eraser
Retouching: adding and erasing lines

All TactileView designs have a bitmap that acts as the 'base layer'. This bitmap layer can be edited using the retouching tools.


Retouching

To draw freehand lines that are automatically part of the bitmap and not editable, select the 'Retouching Adding lines' icon from the toolbar on the left side of the screen, or select 'Retouching: Adding lines' from the Drawing Tools menu. Select the line thickness you would like to use prior to starting to draw by using the slider next to the properties toolbar. You can use Shift + scroll wheel for more convenient size adjustment while drawing in the design. In the properties toolbar or context menu, you can choose between a round or a square pen or eraser shape by selecting 'Apply circular tip' or 'Apply square tip'.
You can also choose to draw straight or curved lines by choosing 'Use straight lines' or 'Free style (follow the mouse)'.

You can now use the mouse to draw in the design area. Anything you draw with this tool will automatically be part of the bitmap and will not be editable unless you select an area containing your drawing and convert it to a figure or use the 'Detect shape' feature to create an editable object from a freehand closed shape. The retouching mode will continue until you select another mode or drawing tool, or until you press the escape key on the keyboard.


'Retouching: Adding lines' icon: [image: ]

'Line thickness' icon: [image: ]











[image: ]Figure 1. Use the slider or Shift+Scroll wheel to adjust the line thickness. 'Use straight lines' icon: [image: ]
'Free style (follow the mouse)' icon: [image: ]

[image: ]

Figure 2. Drawing straight or curved lines.


'Apply circular tip' icon:
'Apply square tip' icon:

[image: ]

Figure 3. Using a circular or square pen tip.


Eraser

To erase lines in the bitmap, select the 'Retouching: Erase' icon from the tool bar on the left side of the screen, or select 'Retouching: Erase' from the Drawing Tools menu. The eraser width and shape can be adjusted in the same way as the line thickness of the pen, as well as using straight or curved lines and a circular or square eraser.

Begin erasing by dragging the mouse over the lines you would like to erase. The retouching mode will continue until you select another mode or drawing tool, or until you press the escape key on the keyboard. You can only erase any lines fused to the bitmap. Therefore, if you wish to erase a part of a blue object or inserted image, you will first need to fuse them with the bitmap. 

[image: ]
'Retouching: erase' icon: 

'Eraser width' icon:
'Use straight lines' icon:
'Free style (follow the mouse)' icon: [image: ]

[image: ]

Figure 4. Using the eraser to retouch a section in the design.

5.08 [bookmark: 5.08_Draw_objects;_line,_square,_circle,][bookmark: _Toc205893283]Draw objects; line, square, circle, ...

The drawing tools icon bar contains all the drawing tools to create objects with specific shapes such as lines, dots, circles and squares. The objects provide accuracy in your drawings and are indicated in blue on screen.

General operation for the tools

After selecting a drawing tool, a second vertical toolbar will appear. Depending on the tool, this toolbar will present you with a number of options that can be selected before the object is placed in the design.

To place the object, move the mouse to the drawing area and click where the object should be placed. The cursor will also indicate the selected drawing tool. Hold and drag or click in a second position to determine the size and position of the object. Purple markers on or around the objects allow for repositioning, resizing or changing the proportions.

An object can be deleted by the delete key or selecting 'Delete' from the icon bar or context menu. It is not possible to erase parts from the object unless it has been fused to the bitmap.

After placing an object in the design, a second vertical toolbar will appear, presenting the specific properties for the drawn object. Reselecting the object later will bring up the same properties icon bar.

A number of properties are common for all objects. These will be explained in a separate section: Common properties for objects.

Drawing straight lines

To draw a straight line, choose the 'Draw Straight Line' icon from the toolbar on the left side of the screen. In the design area, click the starting position for your line, then click the end position.





[image: ]

Figure 1. Drawing a straight line in the design. 'Draw straight line' icon: [image: ]




Drawing squares and rectangles

To draw a square, choose the Draw Square-Rectangle icon from the tool bar on the left side of the screen. Click in the design to mark the position of the first corner, then move the mouse to determine the size of the square and click a second time to confirm. Alternatively, you can click and drag, then release at the opposite corner.

By dragging the markers in one of the four corners the size can be increased or decreased. Dragging inwards or outwards with the markers in the middle of the four sides will turn the square into a rectangle.






[image: ]


Figure 2. A square and rectangle drawn in the design. 'Draw square-rectangle' icon: [image: ]




Drawing circles and ellipses

To draw a circle, choose the 'Draw Circle-Ellipse' icon from the left vertical tool bar on the left side of the

screen. In the design area, click the location for the first position, then move the mouse until the circle is the desired size and click again to confirm. Alternatively, you can click and drag, then release at the opposite corner.

By dragging the markers in one of the four corners the size can be increased or decreased. Dragging inwards or outwards with the markers in the middle of the four sides will turn the circle into an ellipse.






[image: ]



Figure 3. A circle and ellipse drawn in the design.

'Draw circle-ellipse' icon: [image: ]






Drawing triangles

To insert a triangle into your drawing, select the 'Draw Triangle' icon from the left vertical toolbar. Next, select what type of triangle to insert from the right vertical properties tool bar that appears.

The bottom four icons on this tool bar show the available types of triangles. From top to bottom, the triangle types available in the tool bar are right, isosceles, equilateral and scalene. Triangles may be changed from one type to another after you have placed them in your drawing, but it is easiest to select the appropriate triangle type prior to inserting the shape.

Once you have selected the type of triangle you want, click the point in the design area where you want one of the corners and then drag until the triangle is the desired size. Alternatively, you can click and drag, then release at the opposite corner.

The 'Angles and lines' dialog can be used for a more mathematically oriented notation. The corners of the

triangle are marked with letters A, B and C. By default they will only show on screen (green colour). By checking 'Characters A, B, C at angular points' in the 'Angles and lines' dialog, they will also be presented in braille characters once embossed.

Triangles can be provided with 3 types of specific lines: altitude, median line and bisector, which will be embossed as dotted lines.





[image: ]


Figure 4. Four different types of triangles: right, isosceles, equilateral and scalene. Equal or right corners are indicated in green.

'Draw triangle' icon: [image: ]






Drawing polygons

A polygon consists of several lines that are connected as one object. To insert a polygon, choose the 'Draw Polygon' icon from the tool bar on the left side of the screen. Click in a number of positions in the design area to draw a polygon. To finish the polygon, click on the first angular point (first purple marker)

to close the polygon. Alternatively, you can click again on the last placed angular point to make an open shape. You can also choose these two options from the toolbar or context menu by selecting 'Close polygon' or 'Finalize the polygon (leave the last connection open)'.

When you have an open polygon selected, two green plus symbols on screen allow you to continue drawing at the ends of the polygon. You can also choose 'Continue drawing at first/last endpoint' from the context menu. The red border around a selected polygon can be used to resize it by dragging the purple markers.

You can choose between straight and curved lines between the angular points. This allows you to make use of rounded curves in your design.





[image: ]


Figure 5. Two polygons show the difference between straight and curved lines. 'Draw polygon' icon: [image: ]




Drawing freehand line or closed shape

To draw freehand lines or closed shapes, choose the Draw Freehand Line or Closed Shape icon from the tool bar on the left side of the screen. In the design area, click the desired starting location and drag the mouse to create the desired line. To create a closed shape, click the desired starting location and drag the mouse to create the desired shape, returning to the starting location before releasing the mouse button.

As with the polygon, you can choose between straight and curved lines between the angular points. The dashed red border can be used to resize the entire object.





[image: ]
Freehand line with curved lines.

'Draw freehand line or closed shape' icon: [image: ]






Drawing dots

To add round dots to your design, select the 'Draw filled dots' from the let vertical toolbar, then click in your design to position the dot. The size of the dot can be changed with the purple markers. The dot size can range from only one braille dot up to a large filled circle of multiple centimetres in diameter.

[image: ]
Different sized dots can range from a single braille dot to several centimeters in diameter.
'Draw filled dots' icon: [image: ]

5.09 [bookmark: 5.09_Draw_table][bookmark: _Toc205893284]Draw table
TactileView includes a number of tools for drawing and working with tables. As drawing objects, most editing commands for tables are the same as for other drawing objects, including the methods with which to move, center or delete a table, change its line or fill style, add audio labels or fuse it to the bitmap. The features and commands described in this tutorial are specific to tables.

Drawing a table

To add a table to your file, choose the 'Draw table' icon from the toolbar on the left side of the screen, then click and drag the mouse in the design to insert a table into your document. Your table will be created with the default number of rows and columns, but you can add and/or remove rows and columns as desired after the table has been inserted.

Another way to add a table to your file is to select 'Draw table' from the Drawing Tools menu. This launches a dialog, allowing you finer control over how the table is initially created.

To insert a table using this method, enter the desired location of the upper left corner of the table, then specify the size parameters, the number of rows desired and the number of columns desired. When setting the size, choose the 'Enlarge/reduce' radio button if you would like the cells in your table to be square, or choose the 'Stretch' radio button to allow adjustment of the height and width independently. Enter the desired cell width (and the height, if using the 'Stretch' option), the desired number of rows and the desired number of columns, then choose 'OK' to close the dialog and insert the table into your drawing.


[image: ]



Figure 1. Drawing a table in the design with the mouse. 'Draw table' icon: [image: ]

Adjusting the table size

Once you have inserted the table into your drawing, you can adjust the overall table size. To do this, select the table so that purple squares appear along the outside edges of the table. To scale the table and preserve the height to width ratio, click a purple square in one of the corners of the table and drag it until the table is the desired size. The cells in the table will be scaled up or down automatically with the table and will maintain their height to width ratios.

To adjust the overall table width, click the center purple square on the right or left edge of the table and drag it until the table is the desired width. The cells in the table will be scaled automatically to maintain equal widths. Similarly, you can adjust the overall table height by clicking the center purple square on the top or bottom edge of the table and dragging it until the table is the desired height. The cells in the table will be scaled automatically to maintain equal heights.

Adding and removing rows and columns

If you created your table using the tool bar icons and the default number of columns and/or rows is not what you need, you can add or remove rows or columns.
To add a row, select the table and choose the 'Add row' icon from the tool bar at the left side of the screen, or right-click the table and choose 'Add row' from the context menu. A dialog will appear, allowing you to choose where in the table to add the row and how to change the size of the table or rows to accommodate the new row.

First, choose the 'Keep table' dimensions radio button if you want to maintain the current outer dimensions of the table (scale the row height of all rows down to add the new row without changing the overall table size), or choose the 'Keep cell dimensions' radio button if you want to add a row with the same dimensions as the cells currently in the table (increase the overall height of the table to add the new row with the same row height as current rows). Next, select where to add the new row. To add the new row at the top of the table, choose the 'In front' button to close the dialog and add the row. To add it at the bottom of the table, choose the 'At the end' button to close the dialog and add the row. To add it somewhere else in the table, use the 'After row' edit box to enter the row number after which the new row should be added, then choose 'OK' to close the dialog and add the row.

To remove a row, select the table and choose the 'Delete row' icon from the tool bar at the left side of the screen, or right-click the table and choose Delete Row from the context menu. A dialog will appear, allowing you to choose which row in the table to remove and how to change the size of the table or remaining rows once it’s removed.

First, choose the 'Keep table' dimensions radio button if you want to maintain the current outer dimensions of the table (increase the row height of all remaining rows to remove the row without changing the overall table size), or choose the 'Keep cell' dimensions radio button if you want to remove the row without changing the height of the remaining rows (decrease the overall height of the table when the row is removed). Next, choose which row to remove. To delete the row at the top of the table, choose the 'First' button to close the dialog and remove the row. To delete the row at the bottom of the table, choose the 'Last' button to close the dialog and delete the row. To delete any row in between, use the 'Delete row' edit box to enter the row number to remove, then choose 'OK' to close the dialog and delete the row.

Similarly, you can add or remove columns in the same way as described for rows. Instead, select the 'Add column' icon from the properties toolbar or right click the table and choose 'Add column' from the context menu. To remove a column, select the table and choose the 'Delete column icon' from the toolbar at the left side of the screen, or right-click the table and choose Delete Column from the context menu.
Similar dialogs will appear, in which you can select where to add or remove a column in the table.

'Add row' icon:

'Add column' icon:

'Remove row' icon:

'Remove column' icon:



Entering table contents

At any point after creating your table, you can enter contents into the cells. You can use the drawing tools from the left vertical toolbar or Drawing tool menu to place text labels or object in the table. Objects inserted into a table may be edited just like objects that are not part of table contents.  Inserting an object into the table contents will anchor it to the table, so that if you later move, stretch or scale the table, the object stays linked to the correct cell in the table.

As an alternative to drawing the object with the mouse, select the table and choose the 'Table contents' icon from the properties toolbar, or right-click the table and choose 'Table contents' from the context menu. This launches a dialog from which you can control the table content.

When you select an object type from this menu, a dialog will come up allowing you to give further information about the object you want to create. The dialog will vary depending on which type of object you select. A size and position dialog will appear for straight lines, squares/rectangles, circles/ellipses, triangles, polygons, freehand lines/closed shapes, dots and tables. For the other objects, a dialog will appear in which the contents can be entered (e.g. text labels) or selected (e.g. figures).

The dialogs are very similar to the ones that appear when you access the drawing tools from the Drawing Tools menu, except that they also have edit boxes that allow you to select which cell to place the object in by specifying the desired row and column for the object.

This is the size and position dialog for inserting a square, but since it is being inserted into a table it has Row in Table and Column in Table edit boxes at the bottom. Make the desired selections to create your object and place it in the appropriate cell, then choose OK to close the dialog and insert the object into the table. It will also appear as a listing in the table contents menu.


[image: ]

Figure 2. Scaling or moving a table will automatically reposition the contents in the table. 'Table contents' icon: [image: ]

5.10 [bookmark: 5.10_Draw_graph][bookmark: _Toc205893285]Draw graph
The 'Draw graph' icon shows the list of options for creating a tactile mathematical graph. You can also find these options in the Graphs menu. From this list, you have a choice to either use an empty grid, create a graph by entering your own formula or using one of the TactileView example graphs.

'Draw graph' icon: [image: ]

5.11 [bookmark: 5.11_Add_figure_(image_files_or_arrows,_][bookmark: _Toc205893286]Add figure (image files or arrows, symbols, ...)
To add arrows or other commonly used shapes, choose the 'Add Figure' icon from the tool bar on the left side of the screen, then select 'Add figure' again from the second vertical toolbar. In the design area, click on the point where you want the figure to be inserted. A dialog containing a list of available figure categories including arrows, electrical symbols and more appears. (NOTE: You can also add your own commonly used shapes as figures so that you can easily insert them into files. 



'Add figure' icon: [image: ]






[image: ]

Figure 1. From the dialog, choose one of the figures supplied with TactileView, or insert one of your own saved images.

Browse through the categories and select a figure to add, then choose 'OK' to place the figure in the

design. If the object is not the desired size when it appears in the design area, you can edit it by dragging the purple markers on the corners and sides.

Alternatively, you can insert a saved image file as a figure in the design. You can choose 'Import SVG' to insert a svg image in your design, or 'Import image from file' to insert a bitmap image (.jpg, .png, ...) as a figure.




'Add figure' icon:
'Add figure' icon:

5.12 [bookmark: 5.12_Draw_mammoth_braille][bookmark: _Toc205893287]Draw mammoth braille
The dots of braille characters normally have a fixed distance, but this can be enlarged. In TactileView, the greatly enlarged braille is called 'mammoth braille' to distinguish from Jumbo braille (braille with increased dot distance).

NOTE: Mammoth braille is not used to place braille texts in the design, but could be used for 'fun' applications such as writing a name in a large braille character type. The braille dots will be displayed in blue on screen. The character that is represented by the dots is shown in grey behind the braille dots.

To draw a large braille in the design, select the 'Draw mammoth braille' from the drawing tool menu item.  Enter the contents in the dialog that appears and click 'OK'. You can use the purple markers to resize the enlarged braille.

[image: ]

Figure 1. Mammoth braille inserted in the design.
[image: ]


Figure 2. The dot size of mammoth braille can be enlarged, as opposed to regular braille.
'Braille dot size' icon: [image: ]

5.13 [bookmark: 5.13_Draw_letters_and_digits][bookmark: _Toc205893288]Draw letters and digits
NOTE: Keep in mind that this drawing tool is not intended to present texts in braille, but as a tool to show the contours and shapes of visual text characters. Various font types and font sizes can be used to illustrate font attributes such as serif, italic or bold.

To draw a text in the design, select the 'Draw letters and digits' icon from the left vertical toolbar. Click in the design where you wish to place the large text. Enter the contents in the dialog that appears and click 'OK'. You can use the purple markers to resize the text, which should be large enough for tactile use to distinguish the characters.





'Draw letters and digits' icon: [image: ]


[image: ]

Figure 1. Add large text to your design with 'Draw letters and digits'

[image: ]

Figure 2. Font type and size for letters and digits can be adjusted. 'Font type and size' icon: [image: ]

6.01 [bookmark: 6.01_Different_types_of_text_labels][bookmark: _Toc205893289]Different types of text labels
You may add text format labels to a file at any time. There are several formats of labels available for use in TactileView. The most commonly used type of label in TactileView is referred to simply as a “text label.” Text labels may be entered in plain text and be automatically translated to braille when they appear in the document, or they may be entered directly in braille through six-key input.

In addition to text labels, TactileView offers the option to add mammoth braille labels or print character labels that will be embossed as raised text.

NOTE:
Labels may only be edited according to the input method used to create them. For example, a text label entered via braille (six-key) input may only be edited using six-key, and a raised print character label may only be edited as a raised print character label. Labels can’t be converted from one type of label to another.

Adding text labels

The most commonly used type of label in TactileView is referred to simply as a “text label.” Text labels may be entered in plain text, and then they are automatically translated to braille when they appear in the document. If you do not already have a file open, create or open one in TactileView to work in.

To add a text label, click the Add Text Label icon and then click the location in the design area where you’d like to place your text label. A text label will appear in the design, allowing you to enter your text, which will immediately become visible in the design. If you have not yet selected a braille table for your translation, a dialog will pop up, in which you can select a braille table.

If you’d like, you can adjust the location for the text label by selecting it and dragging it to its desired location in the design. You can also control the width of the text label by selecting the label and clicking and dragging the purple squares surrounding the selected label to adjust its width.

The text label will appear in your file with the braille shown in black with the original text you entered in green on top of it, and there will be a green rectangle on the left edge of the label to indicate a text label entered with the computer keyboard (rather than braille keyboard entry).

Once you’ve inserted a label, you can make additional labels either by following this process again, or you can copy and paste your first label and then edit the text in the copy.

Adding text labels through six-key entry
This option is only available from the tool bar on the left side of the screen. Click the Add Text Label icon and then choose the braille keyboard entry icon. Click the location in which you would like to insert your label and a text label will appear in the design, allowing you to enter your text, which will immediately become visible in the design.

Enter the braille you would like in your label one character at a time. To enter a character, press all letter keys for the dots you want in your character at the same time, then release them at the same time. The letters f, d and s correspond to dots 1, 2 and 3, respectively, in the cell and the letters j, k and l correspond to dots 4, 5 and 6, respectively. For example, the letter n contains dots 1345.

To enter this character, press f, s, j and k all at the same time, then release them.

If you’d like, you can adjust the location for the text label by selecting it and dragging it to its desired location in the design. You can also control the width of the text label by selecting the label and clicking and dragging the purple squares surrounding the selected label to adjust its width.

When you enter a text label using braille input, the label will appear in your file with the braille dots shown in black. It's important to double-check the braille for accuracy, as no green print text will be displayed with this input method.
An orange rectangle will appear on the left edge of the label to indicate that it was entered using the braille keyboard, rather than the standard computer keyboard.

If you input a text label using the braille keyboard (six-key) input method, it may only be edited using six- key. The Add Text Label function will stay in braille keyboard entry mode until you click the Add Text Label icon and then either click the computer keyboard entry icon or right-click in the design area and select Text and position: computer keyboard entry to change it back. The Add Text Label function will also be automatically reset to use computer keyboard entry if you close and reopen the software.

Adding mammoth braille labels

To add mammoth braille labels, select Draw Mammoth Braille from the drawing tools menu item. In the dialog that appears, enter the text you wish to appear in mammoth braille and adjust the position in which it should be inserted if desired. Choose OK to close the dialog and insert the mammoth braille label into your file.

The mammoth braille label will appear in your file with the mammoth braille dots shown in bright blue. The original text you entered will appear behind the mammoth braille in light blue.

Adding raised print character labels

To add print characters that will be embossed in the shape of print letters, choose the Draw Letters and Digits icon from the tool bar on the left side of the screen, then click the location in which you’d like the raised print character label to be inserted. This launches a dialog that allows you to enter the text you wish to appear as print characters and adjust its location in the design area if necessary. Set the options as desired and choose OK to close the dialog and insert the label into your file.

[bookmark: 6.02_Editing_text_labels]
6.02 [bookmark: 6.02_Editing_text_labels_-_revision][bookmark: _Toc205893290]Editing text labels
Any text label placed in the design can still be edited later on. You can change the contents of the label or adjust the size and position in the design.
Please note that labels may only be edited according to the input method used to create them. For example, a text label entered via braille (six-key) input may only be edited using six-key, and a raised print character label may only be edited as a raised print character label. Labels can’t be converted from one type of label to another.

Changing how labels are viewed (computer or braille keyboard entry text labels)
To view only the text of the labels in your document, select a text label and then choose the 'Text Label Presentation: on Screen' icon from the tool bar on the left side of the screen. and then choose Hide Braille on Screen, or right-click a text label and select the 'Text Label Presentation on Screen' option from the context menu to do the same.
Alternatively, to show or hide the braille dots, select a text label and choose the 'Show/Hide Braille Dots on Screen' icon from the tool bar on the left side of the screen, or right-click a text label and select the 'Show braille dots on screen' option from the context menu.

NOTE: Hiding the braille dots on screen does not hide the braille in mammoth braille labels. Braille dots for text labels can be disabled on print separately.




'Text label presentation on screen' icon:

'Show/Hide braille dots on screen' icons:






Cutting, copying, pasting and deleting labels (all label types)
The fastest way to copy, cut, paste or delete a label is using hotkeys. To cut a label, select it and press CTRL+X on the keyboard. Cutting the label removes it from the file but stores it on the clipboard so you can paste it somewhere else in the file. The cut label can only be pasted until you cut or copy a different label or object.
To copy a label, select it and press CTRL+C. Copying leaves the original label but keeps a copy of it that you can paste somewhere else in the file. To paste a cut or copied label, press CTRL+V. To delete a selected label, press the Delete key on the keyboard.

Moving labels (all label types)
Once your label is selected, you can move it by clicking the center and dragging it to a new position. A four pointed arrow cursor indicates you can move the label.
You can also easily move the label to the center of the design area by right-clicking it and selecting Center from the context menu. You can move it only horizontally or only vertically by right-clicking it, selecting 'Move the label or object only horizontally or vertically' and then dragging it up or down to move it vertically without changing its horizontal position, or left or right to move it horizontally without changing its vertical position.




[image: ]Figure 1. The cursor with four arrows indicates the text label will be moved when dragged. 'Centre text label' icon: [image: ]
'Move horizontally/vertically' icon: [image: ]






Resizing labels (mammoth braille labels and raised print character labels only)

You can resize a mammoth braille label in one of two ways. The first way is to scale a mammoth braille label manually. To do this, select it, then click a purple marker in one of the corners of the label and drag it diagonally until the label is the desired size. This resizes the mammoth braille inside the label to fit the new label size. The other way to resize a mammoth braille label is to right-click it and choose 'Braille dot size', which brings up a dialog on which you can specify the size of the mammoth braille relative to standard braille as a percentage. The default percentage is 300, which means the mammoth braille is three times larger than standard braille. Enter the desired size of the mammoth braille and choose OK to close the dialog, adjust the mammoth braille size and automatically resize the label to fit the new size of the mammoth braille.

Raised print character labels may also be resized in one of two ways. The first way is the same as for mammoth braille labels; select the raised print character label, then click a purple square in one of the corners of the label and drag it diagonally until the label is the desired size. This resizes the raised print characters inside the label. The other way is to right-click the raised print character label and choose 'Font type' and size from the context menu. This launches a dialog that allows you to choose any font on your

computer for the label, to specify any available font style for that font and to define the desired font size. Once you have finished making selections, choose OK on this dialog to apply your choices to the label text. The raised print character label will be resized to fit the new size of the text.

NOTE:
Because braille characters have a fixed size, text labels created using either computer keyboard entry or braille keyboard entry may not be resized. However, you can determine the width of the text by adjusting the word wrap of the text label. 


[image: ]
Figure 2. Mammoth braille or letters and digits can be resized using the purple markers.





Rotating labels (all label types)
To rotate a label, right-click it and then choose 'Rotation' from the context menu or click the icon in the toolbar of the selected label. On the dialog that appears, enter the desired angle of rotation in degrees and choose OK to rotate the label. You can also use the scroll wheel on a mouse to rotate a selected label.



'Rotation' icon: [image: ]






Editing text label content
Text labels may only be edited using the same entry method with which they were created (computer keyboard entry or braille keyboard entry). To edit the content of the computer keyboard entry text label, double-click the label to place the cursor in the text and edit the content as desired within the design area. You can also right-click the label and choose 'Text and position: computer keyboard input' or click on the corresponding icon in the toolbar to bring up a text and position dialog. Make the desired changes and choose 'OK' to update the text in the label.

To edit the contents of a braille keyboard (six-key) entry label, right-click it and choose 'Text and position: braille keyboard input' to bring up the text and position dialog. Edit the label content as desired using six-key entry. When you are finished, choose 'OK' to close the dialog and update the label.
Alternatively, you can double click on the label to edit its contents directly in the design area.
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Figure 3. Double click on a text label for direct editing.





Using additional line spacing
You can also choose to use extra line spacing between lines of text throughout the document, which can be selected in the grid settings dialog or by selecting 'Additional line spacing' from the properties toolbar or context menu of a text label. For example, a value of 0.5 will add an empty space of half the height of a braille character between two lines of text. This line spacing is visible on screen in the braille grid.



'Additional line spacing' icon: [image: ]

Editing mammoth braille

To edit the content of a mammoth braille label, right-click it and choose Text and position mammoth braille to bring up the text and position dialog you used to create the label. Edit the label content as desired, then choose OK to close the dialog and update the label.
[bookmark: _bookmark40]
Editing letters and digits

To edit the content of a raised print character label, right-click it and choose Text and position: letters/digits to bring up the text and position dialog you used to create the label. Edit the label content as desired, then choose OK to close the dialog and update the label.






6.03 [bookmark: 6.03_Editing_objects][bookmark: _Toc205893291]Editing objects
NOTE:
This tutorial does not cover the use of the menu driven design feature in TactileView. Please refer to the Accessible Drawing tutorial for more information on editing TactileView files through menu driven design.

TactileView offers a number of ways to edit existing objects. Drawing objects are indicated in blue, and all functions listed here will work for these objects. Most will also work for freehand lines that were converted to objects.

To edit an object, click on it to select it. Purple squares will appear at points used to define the object. In most cases, these squares appear along the outline of the object. Objects inserted using the Add Figure feature and freehand lines that have been turned into objects will be surrounded by a red dashed rectangle, with purple and red squares along the dashed rectangle. If you added a freehand line using the Retouching: Adding Lines option it will appear in black on screen, and you will need to convert it to an object before editing (please refer to the Working with a Fused Bitmap tutorial).

Cutting, copying, pasting and deleting objects (all object types)

The fastest way to copy, cut, paste or delete an object is using hotkeys. To cut an object, select it and press CTRL+X on the keyboard. Cutting the object removes it from the file but remembers it so you can paste it somewhere else in the file. The cut object can only be pasted until you cut or copy a different object. To copy an object, select it and press CTRL+C. Copying leaves the original object but keeps a copy of it that you can paste somewhere else in the file. To paste a cut or copied object, press CTRL+V. To delete a selected object, press the Delete key on the keyboard.

Moving objects (all object types)

Once your object is selected, you can move it by clicking the center and dragging it to a new position. You can also easily move the object to the center of the design area by right-clicking it and selecting Center from the context menu.

Resizing objects (all object types)

To change the width of an object, click a purple square on the left or right edge of the object and drag it horizontally until the object is the desired width. To change the height of an object, click a purple square on the top or bottom edge of the object and drag it vertically until the object is the desired height. To scale an object without changing the height to width ratio, click a purple square in one of the corners of the object and drag it diagonally until the object is the desired size.

In the case of a freehand line or closed shape, or for a polygon, clicking and dragging a purple square will

move only the point located at that purple square. To resize one of these objects, right-click it and choose Size and Position from the context menu. This will bring up a Size and Position dialog.

In the Size section of the dialog, choose the Enlarge/Reduce radio button if you want to scale the object, then specify the desired width or height (the other dimension will adjust accordingly to preserve the original height to width ratio). Choose OK to scale the object. If you want to change the height and/or width independently, choose the Stretch radio button, then make the desired changes to the height and/or width of the object. Choose OK to close the dialog and update the object.

Rotating objects (all object types)

To rotate an object, right-click it and then choose Rotation from the context menu. On the dialog that appears, enter the desired angle of rotation in degrees and choose OK to rotate the object. You can also use the scroll wheel on a mouse to rotate a selected object.

Mirroring objects
(figures and retouched objects)

Mirroring an object keeps it in the same position but flips it horizontally or vertically depending on your selection. Mirroring an object horizontally flips it left to right (like turning a page in a book). Mirroring an object vertically turns it upside down (like flipping a page in a wall calendar). To mirror an object, right-click it and choose Mirror Horizontally or Mirror Vertically from the context menu.

Changing the line style
(does not apply to figures or retouched objects)

Select the object and choose the Line Style icon from the tool bar on the left side of the screen, or right- click the object and select Line Style from the context menu. Either of these methods opens a dialog from which you can set the line properties for the object, including the line pattern (solid or dashed) and thickness. The dialog includes a preview of how your line will look as you make changes. Choose OK to apply your changes to the object and close the dialog.

Changing the fill style
(does not apply to figures or freehand objects)

Select the object and choose the Fill Style icon from the tool bar on the left side of the screen, or right- click the object and select Fill Style from the context menu. Either of these methods opens a dialog from which you can set the fill properties, including selecting a fill texture, scaling the size of the fill tiles and rotating the texture within the object.

If you would like to add a fill texture to your object, select the Use Texture Fill radio button. Choose the Change Texture button to bring up a dialog containing a list of textures that can be used. Select a texture and choose OK. A preview of your texture appears at the bottom of the fill style dialog. Use the Tile Size in Pixels edit box to scale the texture larger or smaller. You can also rotate the texture using the Texture Rotation Angle edit box. When you are finished making changes, choose OK to apply the fill style.

6.04 [bookmark: 6.04_Using_audio_styles][bookmark: _Toc205893292]Using audio styles
Audio styles are a great way to add more information to a drawing without having to make it larger to accommodate more text or graphical information. The audio information is accessed by using the file in explore mode, either on screen or with a mouse

Audio styles can be added to any type of drawing object in TactileView (figures, squares, circles, dots, detected area, etc.). Audio styles may not be added to text labels, because text labels are automatically voiced by text-to-speech when the file is used in explore mode (the text contents of the label is used as an audio style).

Adding an audio style to be voiced by text-to-speech

To add an audio style to be voiced by text-to-speech to an object, select the object and then choose the 'Audio style' icon from the properties toolbar on the left side of the screen or right-click the object and choose 'Audio style' from the context menu. This will launch an audio style dialog, the top section of which allows you to specify the text to be voiced by synthetic speech from one of several sources.

The default choice is the 'Self defined text' radio button, which allows you to type the text you want voiced into the text field on the dialog. If you have text saved in a text file that you would like voiced instead, you can select the 'Text from local file' radio button, then choose the 'Browse' button to browse to and select your text file (.txt file). Once you have specified the text, you can check how the audio style will sound by selecting the 'Test audio style' button. When you are finished making changes, choose the 'OK' button to close the dialog and apply the audio style. The object will be shaded light pink to indicate that an audio style is associated with it.
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Figure 1. The light pink colour signifies an audio style is associated with the circle.




Attaching an existing sound file to an object

You can also attach an existing sound file to an object to have it played when the object is clicked while the file is in explore mode. In the audio style dialog, the bottom section allows you to specify a sound file to be used as an audio style.

The default choice is the 'Local file' radio button, which is used to attach a sound file to the object as an audio style. Select the 'Browse URL' button, locate the sound file you would like to use on your computer and select it. The file path to the sound file will now appear in the text field below the sound file type selection radio buttons. You can check how the audio style will sound by selecting the 'Test audio style' button. When you are finished making changes, choose the 'OK' button to close the dialog and apply the audio style. The light pink colour will now indicate an audio style is associated with the object.

NOTE:
If you have both a text-to-speech audio style and a sound file audio style attached to the same object, the text-to-speech will be voiced first and the sound file will play after it.


Recording an audio style from a microphone

Audio styles recorded from a microphone are played when the object is clicked with the mouse or touch screen while using the file in explore mode. Recorded styles are played after any text-to-speech styles are voiced. Before recording, you will need to ensure that you have a microphone connected to your computer. You can connect your microphone via the 'Microphone' dialog in the Settings menu.

When you have connected a microphone to your computer, you can record an audio style for an object by selecting the object, then choosing the 'Record microphone' icon from the properties toolbar on the left side of the screen, or by right-clicking the object and choosing 'Record microphone' from the context menu. As soon as you select this, recording begins and the icon in the tool bar changes to the 'Stop recording' icon. When you have finished speaking into the microphone, choose the 'Stop recording' icon from the tool bar or right-click the object and select 'Stop recording' from the context menu to stop the recording. Your recording will play back automatically as soon as you stop the recording, and the object will be shaded light pink to indicate that an audio style is associated with it.
NOTE:
Each object may only have one text-to-speech audio style and one recorded or sound file audio style associated with it. If you record an audio style for an object, it will replace any existing sound file you may have associated with that object previously.

Audio style icon: [image: ]







Editing an existing audio style

To edit any type of audio style, select the object with the audio style you want to edit and then choose the Audio Style icon from the tool bar on the left side of the screen or right-click the object and choose Audio Style from the context menu. This will launch the same audio style dialog you used to create a text-to- speech audio style or attach an existing sound file.

To edit a synthesized speech audio style from self-defined text, edit the text in the text field. You can also remove the text-to-speech audio style by deleting the text from the text field in the top section of the dialog.

To edit a synthesized speech audio style from text from a local file, you will need to edit the text within the text file itself. To load text from a different file, select the Browse button, locate the new text file you would like to use and select it. You can also remove this audio style by deleting the file path to the local file from the text field in the top section of the dialog.

To edit an audio style played from a sound file, choose the 'Browse URL' button, browse to a different sound file on your computer and select it. It will replace the previous sound file, including any sound file recorded from a microphone, as the audio style for that object. To remove the sound file audio style, delete the file path of the sound file from the text field in the bottom section of the dialog.

When you are finished making changes, choose the 'OK' button to close the dialog and apply your changes.

If you would like to re-record an audio style from your microphone, simply follow the steps given above for recording from a microphone. You do not need to open the audio style dialog to do this. Please remember that recording an audio style for an object from the microphone will overwrite any other sound file audio style for that object.


7.01 [bookmark: 7.01_Introduction_on_mathematical_notati][bookmark: _bookmark43][bookmark: _Toc205893293]Introduction on mathematical notations
Equations for sighted users are usually written in a spatial arrangement, in such a way that the components and their relations can be understood from their relative positioning. For example, a division is depicted by placing the dividend above the divisor, separated by a horizontal division line.

For printing in braille, this spatial arrangement has to be converted into a continuous line of braille characters. Mathematical symbols such as (large) brackets, square roots and many other non-day-to-day symbols have to be converted as well. This all depends on the mathematical braille code that is being used. 

Mathematical notations and braille tables

Since computers began to play a role in math and science, it has become even more a necessity to find an unambiguous way of presenting the results (in braille as well). Many of the equation editors use MathML as their universal language to store and manipulate mathematical equations. This language is also used to add equations to your design in TactileView.

In order to get the correct equation printed in braille, a 2-step conversion is required: applying mathematical notation rules and applying a braille table to translate the characters into the corresponding braille dots.
[image: ]

Figure 1. Conversion from an equation in MathType to a mathematical text label in TactileView, by applying the chosen mathematical notation (in this case LaTeX) and braille table (en-us-comp8.ctb).

A math notation applies a set of rules that convert the spatial elements from the graphical lay-out (MathML) into a continuous line of text. Extra characters need to be inserted to indicate the relationship of the parts, to depict special mathematical symbols or to signify the logical order of the elements.
Amongst other, the Nemeth, Unified English Braille, LaTeX, Marburg and Dedicon are some of the better known math notations and are available in TactileView.

The result of the first conversion step is that the equation has become readable as text in a linear instead of a spatial arrangement. During the second step, a 'braille translator' (in TactileView, the open source project LibLouis is used) applies the desired braille table to convert the linear text of the equation into the corresponding braille characters.

7.02 [bookmark: 7.02_Add_mathematical_label_(equation)][bookmark: _bookmark44][bookmark: _Toc205893294]Add mathematical label (equation)
Currently, there are four options for entering a mathematical text label in your TactileView design:

1. Enter the equation in a regular text label, using the corresponding braille table;
2. Use six-key entry (braille keyboard) to directly enter the math in braille;
3. Enter the mathematical expression using a math editor (MathType)
4. Enter equation in linear notation and have it convert automatically 

Options 1 and 2 require knowledge about the mathematical braille notation you are using in order to enter the equation correctly. Option 3 allows you to enter math and convert it automatically to the desired notation in braille, but this requires MathType as a math editor. 

1. Using a regular text label

When you know the rules of the mathematical braille notation you wish to use, you can use a regular text label to enter it in your design. Select 'Add text label' from the drawing tools icon bar, then select 'Text and position: computer keyboard input' from the properties toolbar. Click in the design where you want to place the equation. Make sure to include the correct spaces, parentheses and other specific aspects of the mathematical notation. MathType is required when you wish to use symbols that are not on your keyboard.

Next, make sure to select the correct braille table for the notation you are using. You can select the braille table by choosing 'Mathematical notations from the settings menu. Select the preferred math braille table from the available options. The following braille tables are recommended for the different mathematical notations:

· nemeth.ctb for Nemeth;
· ukmaths.ctb for UKmaths;
· marburg.ctb for Marburg notation;
· en-us-comp8.ctb or similar for LaTeX;
· Dutch braille table for Dedicon notation.
· UEB-MATH for unified English Braille 





'Add text label' icon: [image: ]
'Computer keyboard input' icon: [image: ] 'Select braille table' icon: [image: ]



2. Using six-key entry

If you know the mathematical braille code and wish to simply use braille keyboard (six-key) entry for direct input of the desired characters, Select add text label, then select the Braille keyboard input icon from the properties column on the left vertical tool bar.  



'Braille keyboard input' icon: [image: ]




3. Equation with math editor (MathType)

You can use MathType as a math editor to automatically convert the entered equation to the desired braille notation. The math editor is also required to enter math that is too complex to be entered in linear format or when symbols are required that are not available on the keyboard. For more information on using MathType to enter mathematical expressions, please visit their website.

Once you have entered the equation in MathType, select it and copy it to the clipboard (Ctrl+C). Switch to TactileView, select 'Add text label' and choose 'Text and position: math input' from the properties toolbar. Click in the design where you wish to position your mathematical label.

In the dialog that appears, select the preferred mathematical notation and click on 'Paste math equation from clipboard'. The equation will now be displayed in both visual (linear and spatial) and braille format.

The dialog also allows you to adjust the location in which you would like to insert the label (if different than where you originally clicked in the file) by filling in the distance fields. You can size the label by specifying the maximum number of characters you would like it to have before the text wraps to the next line. Choose 'OK' to confirm and close the dialog.



'Math input' icon: [image: ]
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Figure 1. A mathematical equation in TactileView; LaTeX and en-us-comp8.ctb were used as mathematical notation and braille table.

7.03 [bookmark: 7.03_Graph_properties_for_best_tactile_u][bookmark: _bookmark45][bookmark: _Toc205893295]Graph properties for best tactile usability
When it comes to tactile graphs, there are several properties that together determine the tactile usability. The three elements in a graph (the equation in braille, grid paper with coordinate system and the curve of the formula) can be configured individually to achieve the optimal tactile result. Personal preferences of the VIP reader as well as the properties of the printer that will be used both need to be taken into account. Therefore we advise you to test the settings described below first to find what works best for you.

Choosing the best graph properties

The mathematical formula(s) and range of the axes are the most important elements when you create a new graph. All other aspects of the grid are for tactile presentation purposes. Reading a tactile graph can be complex enough on its own, so choosing the optimal settings for your production method (swellpaper or the type of braille embosser) is important. This works best if you can imagine the result of each setting in advance. The list below gives an overview of all the settings that are related to a tactile graph.

Graph properties

1. Coordinate system and grid paper

The coordinate system (the axes of the graph) and grid paper (the regular grid that indicates the values of the graph) form the frame in which the graph will be plotted.
Select 'Positions and appearance' from the properties toolbar or context menu of the graph to access the 'Appearance' settings for the coordinate system and grid paper.

Coordinate system – X and Y axis

· Line thickness of the axis; thicker axis lines can be used to distinguish the axes more easily from the thinner grid lines, but also take up more space and tear more easily on some embossers.

Grid paper

· Draw border to surround the axis; this places a rectangular frame around the entire grid.

· Style of auxiliary lines for grid boxes; you can choose from: line, cross, dot, dash and none.

· Thickness of the auxiliary lines for grid boxes; use thinner lines to make the grid boxes less prominent for better contrast with the formula lines.

· Relief height of auxiliary lines for grid boxes; you can make the grid lines less prominent and more easily distinguished from the axes and formulas by lowering the line height. This is only available for embossers that support variable dot height.
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Figure 1. Differences in line thickness are used for easy tactile distinction between the grid boxes and axes.
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Figure 2. A border is used around the edges of the graph.
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Figure 3. Four different grid box styles: line, dash, cross and dot.
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Figure 4. A lower line height, indicated with a lighter blue colour, can be used for easy distinction of the grid boxes.







2. X and Y axes

These settings can be adjusted separately for the horizontal (X) and vertical (Y) axis.

· Extreme values for the axis; this determines the range in which the graph is shown.

· Subdivision of the axis: units per grid box and units per tick; you can choose the interval that is used for the grid boxes and ticks along the axis to easily read the values of the graph.

· Ticks per text label; you can choose whether a numeric value should be placed at each tick, more spaced out (e.g. 1 text label for every 2 ticks) or only at the origin/ends.

· Number of decimals of the values along the axis; some graphs might require more decimal numbers.

· Position of the labels relative to the graph's border; this allows you to create enough space between the grid and value labels along the axis. In the design, you can also drag the purple marker below or left of the values to move them to the required position with the mouse.

· Name for the axis; by default, these are 'x' and 'y', but you can change this to suit the graph (e.g. 'Number purchased' and 'Price').

· Horizontal and vertical position of the axis name; these determine the position of the axis name label. In the design, you can drag this label to the required position with the mouse. Double click on a formula label to edit it.





[image: ]


Figure 5. The range for the axes and positions of the ticks, grid boxes and value labels determines the layout of the axes of the graph


[image: ]

Figure 6. The axes can be labeled individually (X and Y are the default labels).


3. Formula lines

The settings for each formula line that is presented in the graph can be adjusted separately.

· Formula syntax; enter the mathematical equation that will be plotted.

· Text label representation of the formula; the legend above the graph shows which formulas are presented. You can choose from an number of mathematical representations; alternatively, you can choose to enter your own name (e.g. 'Surface area') or choose not to include a label.

· Line style for the formula; by default, each formula gets a different tactile line style to distinguish multiple formulas in a graph. This line style is also presented in the formula legend above the graph. Different colours are used on screen for easy visual recognition.

· Position of the text label; by default, the text labels for the formulas are placed above the graph. In the design, you can also move these with the mouse.
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Figure 7. Different line styles are used for the formulas in the graph, as signified in the formula legend. Different colours are used on screen to easily distinguish the formulas visually.

7.04 [bookmark: 7.04_Creating_a_graph][bookmark: _bookmark46][bookmark: _Toc205893296]Creating a graph
TactileView offers a very powerful graphing feature, which allows you to enter formulas and have them graphed over a specified range. TactileView gives you precise control over the styles used in your graph for the functions, axes, gridlines, labels and more. You can also move and resize your graph like any other drawing object.

There are several possible approaches to creating a new graph. You can choose an empty grid as a basis (see paragraph 1), select one of the TactileView graph examples and adapt it to form your own (see paragraphs 2 and 3), or create a new graph based on the entered formula (see paragraphs 4 and 5). You can also save any graph as 'MyGrid' for reuse in later designs (see section 'Save graph as MyGrid for later use').

1. Coordinate system (no functions)

To enter an empty coordinate system (empty grid paper without any graphed formulas), select 'Draw graph' from the drawing tools icon bar, then choose 'Coordinate system (no functions)' from the properties toolbar. This option can also be found in the Graphs menu.

Once this option is selected, an empty grid will appear in the design. By default, this grid is square and ranges from -4 to 4 on both the x- and y-axis, with straight grid lines at an interval of 1 unit. You can use the options in the properties toolbar or context menu to adjust the properties of the grid or add a graphed formula.


Coordinate system (no functions) icon: [image: ]
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Figure 1. Empty grid inserted in a TactileView design.








2. Functions and formulas (examples)

TactileView includes two sets of ready to use example grids. These have already been optimized to depict the selected formula. You can use these graphs as a basis for your own by simply changing the formula(s).

Select 'Draw graph' from the drawing tools icon bar, then choose 'Functions and formulas (examples)' from the properties toolbar. Alternatively, this option can also be found in the Graphs menu.

In the dialog that appears you will find a list of sample graphs which each include one formula, ranging from simple to more complex. By choosing 'Change formula', you can edit the formula to create your own graph based on the sample. 'Change coordinate system' allows you to adjust the settings for the grid style and properties of the axes (such as the range). Use 'Multiple formulas' to add extra formulas to the grid (for more information on including multiple formulas in one grid, read the 'Graphing multiple lines' section).

Once you have selected a sample graph or when you are satisfied with the adjustments, you can choose to insert the graph a blank new document (click 'Save in new document') or place it in the currently active document (click 'Save in current document'). You can also choose to replace the most recent grid in the current document (click 'Replace the last grid').





'Functions and formulas (examples)' icon: [image: ]
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Figure 2. 'Functions and formulas (examples)' dialog; click on the image to enlarge.





3. Grids and graphs (advanced examples)

Similar to 'Functions and formulas', the 'Grids and graphs' dialog contains a list of sample grids that can be used as is, or adapted to create your own grids. The list contains a number of variations of empty grids, as well as a list of grids that contain one or more formulas (arranged from simple to more complex).
These examples are labelled as numbered TVGrids. Below these TVGrids, you will find any grids that were saved for reuse as MyGrids.

You can access this list of sample grids by selecting 'Draw graph' from the drawing tools icon bar, then choosing 'Grids and graphs (advanced examples)' from the properties toolbar. Alternatively, this option can also be found in the Graphs menu.

The list of properties of the selected sample graph is shown in the second list box. If you wish to adjust any of the settings, select it from this list and click 'Change properties'.

If you have selected one of the MyGrids from the list, you have the option to remove it from the list of saved grids. When you have adjusted the selected MyGrid, you have the option to either save it as a new MyGrid or replace the edited MyGrid.

Once you have selected a sample graph, MyGrid or when you are satisfied with the adjustments, you can choose to insert the graph a blank new document (click 'Save in new document') or place it in the currently active document (click 'Save in current document'). You can also choose to replace the most recent grid in the current document (click 'Replace the last grid').

'Grids and graphs (advanced examples)' icon: [image: ]
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Figure 3. 'Grids and graphs (advanced examples)' dialog; click on the image to enlarge.





4. Add custom graph: equation editor

This option allows you to create a graph based on a formula that is entered using MathType as an equation editor. The math editor is also required to enter math that is too complex to be entered in linear format or when symbols are required that are not available on the keyboard. For more information on using MathType to enter mathematical expressions, please visit their website.

Once you have entered the equation in MathType, select it and copy it to the clipboard (Ctrl+C). Make sure that the entered formula is suitable for conversion to a graph. Next, switch to TactileView and select 'Draw graph' from the drawing tools icon bar, then choose 'Add custom graph: equation editor' from the properties toolbar. Alternatively, this option can also be found in the Graphs menu.

In the dialog that appears, select the preferred mathematical notation and click on 'Paste math equation from clipboard'. The equation will now be displayed in both visual (linear and spatial) and braille format. Choose 'OK' to confirm.

In the formula dialog that appears, the options below the formula as well as the buttons 'Positions and appearance', 'Horizontal (x) axis' and 'Vertical (y) axis' allow you to adjust all the grid properties, formula labels, line style and axis properties; you can read an overview in the 'Graph properties' section. Use the 'Apply' button to refresh the graph preview after you have made any changes to the graph.

Once you are satisfied with the composed graph, select 'OK' to close the dialog and insert the graph in the design.





'Add custom graph: equation editor' icon: [image: ]
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Figure 4. 'Add custom graph: keyboard input' dialog; click on the image to enlarge.





5. Add custom graph: keyboard input

When you activate 'Add custom graph: keyboard input' from the Graphs menu or from the properties toolbar of 'Draw graph', a formula dialog will open. Enter the formula in the first entry field, making sure to use the correct syntax (e.g. 2*x instead of 2x, x^2 for x squared, etc.) similar to entering an equation in software such as Microsoft Excel. You can also select elements from the list of available functions and constants and insert them into the formula by double clicking on it or pressing the Enter key.

Once again, the options below the formula as well as the buttons 'Positions and appearance', 'Horizontal
(x) axis' and 'Vertical (y) axis' allow you to adjust all the grid properties, formula labels, line style and axis properties; you can read an overview in the 'Graph properties' section. Use the 'Apply' button to refresh the graph preview after you have made any changes to the graph.

Once you are satisfied with the composed graph, select 'OK' to close the dialog and insert the graph in the design.





'Add custom graph: keyboard input' icon: [image: ]
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Figure 5. 'Add custom graph: keyboard input' dialog; click on the image to enlarge.

7.05 [bookmark: 7.05_Graphing_multiple_lines][bookmark: _bookmark47][bookmark: _Toc205893297]Graphing multiple lines
TactileView provides the ability to graph four or more formulas at the same time. In the 'Creating a graph' section you can read how to prepare a graph with a single formula, to which you can add additional formulas as described below.

Adding a formula

Select the graph in your design to which you wish to add a formula. Similar to creating a new graph, when adding a formula you need to choose which input method you want to use: you can either enter the formula with MathType as an equation editor, or use the keyboard to enter the formula. From the properties toolbar or context menu of the selected graph, choose 'Add function: keyboard input' or 'Add function: equation editor'. In the dialog that appears, you can enter your new formula in the same way as when you created the graph.

Notice that by default a dashed line style is selected to distinguish the different formulas from each other, but you can change this to Line, Dot or Long/Short Broken if you wish. It is recommended to choose a different line style for each formula you enter. The legend above the graph shows which formula corresponds with which line style. On screen, four different colours are used to easily distinguish between the formulas.

You can apply any changes in the graph preview on the right side of the dialog at any time by choosing the 'Apply' button. When you are satisfied with the selected options for the new formula dialog, choose the 'OK' button to save your changes, close the dialog and update your graph. In the properties toolbar you will see that the icon for 'Formula 2' is no longer greyed out, indicating that a second formula is present in the graph.

You can add a third or fourth formula by following this same process after selecting the graph and choosing 'Add function: keyboard input' or 'Add function: equation editor' from the properties toolbar or context menu. If you wish to include more than four formulas, you will need to add the remaining formulas to one of the first four, seperated by a semicolon: e.g. sin(x^2);cos(x^2). These will be plotted as seperate lines, but with the same line style and other properties.






'Add function: keyboard input' icon:

'Add function: equation editor' icon:

'Formula 1-4' icons:


[image: ]

Figure 1. Different line styles, such as dashed or dotted lines, are used to distinguish different formulas in a graph; on screen, colours are used to signify these differences.

7.06 [bookmark: 7.06_Saving_grids_as_MyGrids][bookmark: _bookmark48][bookmark: _Toc205893298]Saving grids as MyGrids
The example grids (empty grid paper as well as graphs) are called TVGrids. These examples can be modified to use them as the basis for your own graphs. Any grid can be added to this list by saving them as MyGrids. This allows you to easily store them for later use. You can find your saved MyGrids below the list of TVGrids in 'Grids and graphs (advanced examples)'.

You can save a selected grid as MyGrid by selecting 'Add to MyGrids' from the properties toolbar or context menu. Enter a grid name as a reference, then click 'Yes' to save the grid.



'Add to MyGrids' icon: [image: ]






Menu Graphs - Update MyGrids

If you wish to modify or remove any of the saved MyGrids, select 'Update MyGrids' from the Graphs menu and select one from the list.

To modify a MyGrid, select 'Change properties' to make the desired changes. After you have applied the changes, you can choose to save the modified grid as a new MyGrid by selecting 'Add modified grid to MyGrids' or overwrite the existing one by choosing 'Replace changed grid in MyGrids'. You can also choose to delete one of the MyGrids from the list by selecting 'Remove grid from MyGrids'.


[image: ]


Figure 1. The 'Update MyGrids' dialog allows you to edit the list of saved graphs; click on the image to enlarge.

8.01 [bookmark: 8.01_Inserting_graphics_in_Duxbury_Brail][bookmark: _bookmark49][bookmark: _Toc205893299]Inserting graphics in Duxbury Braille Translator
When you have both TactileView 2.200 or higher, and Duxbury Braille Translator (DBT) 11.3 or higher installed, you will be able to insert a TactileView design into a text in DBT. This produces a document containing both text and graphics. You can choose to add a completely new design or use an existing file. The available space for the image will automatically be taken into account.

If you do not have DBT installed yet, please visit their website.

1. Preparing DBT document
Launch DBT, create a new document and add the text in which you wish to insert tactile graphics. You can find more information on working in DBT, creating files and producing the correct braille translation on their website.









2. Inserting existing images
In order to insert a design, move the caret to the position in the DBT text where you want to insert an image. Select Layout > Picture > Add.., then select the desired TactileView design (.bpx file) and click Open. The tactile image is now inserted in the DBT text file. The small yellow logo in the upper right corner of the image indicates that the graphic was created in TactileView.


[image: ]






3. Image positioning
You can choose to insert an image either before or after translation of the braille document (ctrl+T). Either way, the amount of space needed on the page for the image is automatically taken into account. If the image is too large to fit on the current page, it will be placed at the top of the following page. Any empty white space around the edges of the TactileView design will be removed automatically for optimal use of space. For the best results, make sure that the same embosser and paper size are selected in TactileView and DBT. In TactileView, the red border indicates the available printable area for the selected combination of embosser and paper size.


[image: ]






4. Editing inserted images
If you wish to edit the inserted tactile graphics, simply double click on the image in DBT. This will launch the TactileView software, in which you can make any desired adjustments. Once you are satisfied,

you can save the changes by clicking on the 'Insert design in external text file' icon in the top right corner of the canvas area, or select File > Insert design in external text file.



Icon for Insert design in external text file: [image: ]






5. Removing images
You can remove inserted images by moving the caret position right after the image and pressing backspace, or delete with the caret just before the image.









6. Printing combined text and graphics files
An embosser that supports printing tactile graphics is required for printing the DBT file containing the images. In TactileView, you can see a preview of the graphic output of the selected embosser by selecting menu View > Design mode: dot view, or by viewing the print preview.

9.01 [bookmark: 9.01_Accessibility_with_a_screen_reader_][bookmark: _bookmark50][bookmark: _Toc205893300]Accessibility with a screen reader (introduction)
The TactileView software is fully accessible with a screen reader. Due to its visual nature, creating a tactile design from scratch is very challenging for users. However, many other aspects of the software can be used without the need for a sighted designer. This section will give an overview of the suitability for screen reader users of different aspects of TactileView.

Accessible menus

All menus and dialogs are accessible. Some of the menus are specially designed for screen reader users. Extra messages besides those of the screen reader itself are read out to provide additional explanations where appropriate.

Make sure the Settings menu Speech has been covered to make full use of these audible messages.

Mouse/freehand drawing vs. Menu driven design

To follow see the mouse on screen in the drawing area of the software is virtually impossible, even if the position of the mouse would be announced frequently. Keeping track of the created design is impossible with only speech and/or braille.

Existing images can be explored by analysing the colour composition, but how they are curved or the way how the lines intersect cannot be explored without printing the design. Therefore, creating or modifying ‘free-hand’ drawing is a step too far.

As an alternative, objects such as squares, circles and straight lines can be added to the design. Their positions are indicated by their properties (Ctrl+J).

Placing such an object can be done with the menu driven design menu (Ctrl+l).

Things that work really well for a screen reader

Below you will find some of the ways to create a tactile diagram while using a screen reader that work really well.


Download and Edit Design from Catalog (Portal menu)

You can use the catalog to find and download suitable tactile diagrams by selecting a category or

searching for keywords in the title, textlabels or description.

Especially the alternate text that was given by the designer to describe the design can help to determine if this is the required design. The alternate text or description can be extended by any visitor of the catalog to make the description more detailed.

See also the section 'Using the TactileView online catalog'.

Compose map (Portal menu)

To create a tactile map, choose 'Compose map' from the Portal menu. This will open a browser window with the website www.routetactile.com, on which you can create a map of any specified area. You can find a detailed description of all that is involved to create a tactile usable map in the Tactile Maps section.

Create mathematical graphs (Graphs menu)

With a screen reader, you can create a graph of any mathematical formula. You can either enter an equation to create your graph or start from one of the sample graphs in the software. See also the category Graphs and math in the TactileView manual.

Printing designs

You can also print designs on swellpaper or with a braille embosser by choosing 'Print' from the File menu. Print to PDF (for monarch) is to be used when creating tactile graphics for the Monarch. 
You can read more in the Printing section of the manual.

9.02 [bookmark: 9.02_Settings_-_Speech][bookmark: _bookmark51][bookmark: _Toc205893301]Settings - Speech
In most cases, screen reader users will have a speech output for general computer access. For specific applications, screen readers have functionality to monitor certain areas on the screen in order to provide speech output.

The TactileView software can also provide information that is helpful for a screen reader user from the status line of the software or info related to all the many tools and objects.

Language selection and Text-To-Speech (TTS)

Text labels and messages are displayed in the language that was selected in the 'Language' dialog in the Settings menu.

For announcing these texts, a text to speech (TTS) synthesizer has to be selected. Microsoft supplies a few TTS engines with the Windows operating system. Extra TTS synthesisers can be installed from Eloquence, Nuance, L&H or other vendors.

Volume and rate

The volume and rate of spoken messages can be set to find a match with the volume and rate with the speech output of the screen reader. Use the 'Speak' button to test the selected voice, rate and volume.

Speak application messages (select checked)

The software can provide messages in addition to a screen reader. These messages contain status information about the drawing tools and properties of the objects. When you use TactileView with a screen reader, the option 'Use text to speech for application messages and audio style' should be checked.

Speak audio style or text label upon object selection (Select checked)

When an object gets the focus (is selected) the type of object and some properties are announced. For screen reader usage, 'Speak audio style or text label upon object selection' should be checked.

Text to speech for different languages
Some designs may contain texts in different languages, making the text to speech difficult to understand. If possible, it is best to use the TTS that matches the text label language.

For any languages in the list that show 'not defined', the default TTS synthesiser will be used. To apply a specific TTS synthesiser for a certain language, select the language from the list, then select the TTS you wish to use in the list below.

9.03 [bookmark: 9.03_Drawing_tools_-_Menu_driven_design_][bookmark: _bookmark52][bookmark: _Toc205893302]Drawing tools - Menu driven design (Ctrl+L)
TactileView is designed to allow the user to create and edit objects solely through the use of the menus, a feature referred to as “menu-driven design.” This method of creating graphics takes some practice, as you must decide where to place objects based on the distance of a specified critical point for each type of object away from the top and left edges of the design.

Menu-driven design may be used to edit existing graphics or to create new ones. This tutorial describes common functions for adding and editing objects in a drawing.

Adding objects

The drawing tools have been designed to use a coordinate-based drawing system. This means that each time you select a drawing tool, a dialog will appear that lets you specify the location in which the object will be inserted by inputting position and size information for that object.

Drawing straight lines

To draw a straight line, choose the Draw Straight Line option from the Drawing Tools menu. This will bring up a dialog allowing you to specify the position of the start and end points of the line you want to insert. Fill in the horizontal and vertical positions for the start and end points and enter the desired line length, then choose the OK button to close the dialog and insert the line.

Drawing squares and rectangles

To draw a square or rectangle, select the Draw Square-Rectangle option from the Drawing Tools menu. This will bring up a dialog allowing you to specify the size and position of the square or rectangle you want to insert. Fill in the desired position of the upper left corner of the shape. To specify the size, first choose the Enlarge/reduce radio button if you want to insert square or the Stretch radio button if you want to insert a rectangle. Specify the width of the object. If you are inserting a square, you do not need to specify the height. If you are inserting a rectangle, enter the desired height of the object. Select the OK button to close the dialog and insert the object.

Drawing circles and ovals

To draw a circle or oval, choose the Draw Circle-Ellipse option from the Drawing Tools menu. The dialog that comes up allows you to specify the size and position of the circle or oval you want to insert. Enter the position of the center of the circle. Next, choose either the Enlarge/reduce radio button to create a circle or the Stretch radio button to create an oval. Specify the width of your object. If you are inserting a circle, you do not need to enter the height. If you are inserting an oval, enter the desired height of the oval. Select the OK button to close the dialog and insert the object into your file.

Drawing polygons

To insert a polygon, choose the Draw Polygon item from the Drawing Tools menu. A dialog appears,

allowing you to enter the number of points you want in your polygon and define their positions. By default the polygon starts with three points. Select each point from the angular points list and specify its location. The software calculates the angle from the previous point and the distance to the previous point for you. You can add more points by choosing the Add Angular Point button, and you can remove unnecessary points by choosing Delete Angular Point. When you are finished, choose the OK button to close the dialog and insert the shape.

NOTE: Points in the polygon can be added and deleted later when editing the shape with either the context menu options or the mouse.

Drawing triangles

To insert a triangle into your drawing, select the Draw Triangle option from the Drawing Tools menu. The dialog that appears allows you to select the type of triangle you want to insert (right, isosceles, equilateral or scalene) and enter the positions of the points of the triangle. Select each point from the angular points list and enter the desired position. The software calculates the length of each line segment touching the point, as well as the angle between them. When you are finished, choose OK to close the dialog and insert the triangle into your file.

Adding arrows and other figures

To add arrows or other commonly used shapes, choose Add Figure from the Drawing Tools menu. A dialog containing a list of available figure categories including arrows, electrical symbols and more appears. (NOTE: You can also add your own commonly used shapes as figures so that you can easily insert them into files. Please refer to the Adding Figures to the Figure Library tutorial for more information.) Browse through the categories and select a figure to add, then choose OK.

Next a size and position dialog appears, allowing you to specify the position of the figure in your drawing. Choose the Enlarge/reduce radio button if you want to lock the object’s height with respect to the width when choosing the size, or choose the Stretch radio button if you want to define the width and height separately. Choose the OK button to close the dialog and insert the object into your file.

Drawing freehand lines

You can draw a line or closed shape point by point with the menu-driven design by choosing the Draw Free Hand Line-Closed Shape option from the Drawing Tools menu. The same dialog that appears for the Draw Polygon function appears for drawing freehand lines, allowing you to enter the number of points you want in your line or shape and define their positions. By default the line or shape starts with four points. Select each point from the angular points list and specify its location. The software calculates the angle from the previous point and the distance to the previous point for you. You can add more points by choosing the Add Angular Point button, and you can remove unnecessary points by choosing Delete Angular Point. When you are finished, choose the OK button to close the dialog and insert the shape.

NOTE: Points in the line or shape can be added and deleted later when editing it.

Text labels

You may add text format labels to a file at any time. There are several formats of labels available for use in TactileView. The most commonly used type of label in TactileView is referred to simply as a “text label.” Text labels may be entered in plain text and be automatically translated to braille when they appear in the document, or they may be entered directly in braille through six-key input.

In addition to text labels, TactileView offers the option to add mammoth braille labels or print character labels that will be embossed as raised text.

NOTE: Labels may only be edited according to the input method used to create them. For example, a text label entered via braille (six-key) input may only be edited using six-key, and a raised print character label may only be edited as a raised print character label. Labels can’t be converted from one type of
label to another.

Adding text labels

The most commonly used type of label in TactileView is referred to simply as a “text label.” Text labels may be entered in plain text, and then they are automatically translated to braille when they appear in the document.

When using menu-driven design, text labels can be added either by choosing Add Text Label from the Drawing Tools menu of the software, or by opening the List of Objects (Ctrl+L), choosing the Add Text Label or Object button and selecting Add Text Label from the list of options.

A dialog will appear, allowing you to enter the text for your label, select the braille table to use for translation and input position information.

Enter the text you want to use on your label into the Contents box. Select the braille table to use for translation from the Select Braille Table for this Label combo box. [Note: For US English braille, select a table starting with “en-us.” En-us-g1 is the standard US English braille table for producing Grade 1 braille, and en-us-g2 is the standard one for US English Grade 2.]

Enter the location for the text label by editing in the Distance to Left Edge and Distance to Top Edge fields. You can also control the width of the text label by specifying the maximum number of characters you’d like it to have before the text wraps to the next line. Choose OK to close the dialog and insert the label.


Adding mammoth braille labels

When using menu-driven design, mammoth braille labels can be added either by choosing Draw

Mammoth Braille from the Drawing Tools menu of the software, or by opening the List of Objects (Ctrl+L), choosing the Add Text Label or Object button and selecting Draw Mammoth from the list of options. In the dialog that appears, enter the text you wish to appear in mammoth braille and specify the position in which it should be inserted. Choose OK to close the dialog and insert the mammoth braille label into your file.

Adding raised print character labels

When using menu-driven design, raised print character labels can be added either by choosing Draw Letters and Digits from the Drawing Tools menu of the software, or by opening the List of Objects (Ctrl+L), choosing the Add Text Label or Object button and selecting Draw Letters and Digits from the list of options. This launches a dialog that allows you to enter the text you wish to appear as print characters and specify its location in the drawing. Set the options as desired and choose OK to close the dialog and insert the label into your file.

Editing objects Selecting objects
To select an object in the current drawing, open the List of Objects dialog either by choosing Menu Driven Design from the Drawing Tools menu (Alt+T, then M) or with the hotkey Ctrl+L. The List of Objects dialog shows the complete list of drawing objects in the current drawing by object type and gives identifying information about each object. To select an object, arrow through the list until you locate the object you want to work with.

If, after selecting an object, you select the OK button on the List of Objects dialog, the dialog closes and the object you chose is selected. However, most common editing functions may also be performed directly from the List of Objects dialog, and this is the recommended method when using menu-driven design.

Copying, pasting and deleting objects

To copy an object, first press Ctrl+L to bring up the List of Objects dialog. Locate the object you wish to copy, choose the Open Context Menu button and select Copy. The object has now been copied to the clipboard.

To paste an object from the clipboard, choose Paste from the Edit menu (Alt+E, P) or press Ctrl+V. This pastes the object centered at the upper left corner of the design.

To delete an object, first press Ctrl+L to bring up the List of Objects dialog. Locate the object you wish to delete, choose the Open Context Menu button and select Delete.

Moving and resizing objects

Select the object you wish to move or resize from the List of Objects dialog and choose the Open Context Menu button. The context menu is slightly different depending on what object type is selected, but the

position dialog can always be accessed through the first context menu item, which will be Size and Position, Text and Position or Positions of Angular Points. Select this item to bring up the same dialog used to create the object initially, in which you can enter new locations for critical points in the object if you wish to move the object, or enter new height and width settings for objects if you wish to resize them.

You can also center an object horizontally in the drawing by selecting it, choosing the Open Context Menu button and choosing Center. This will only automatically center the object horizontally; it will keep the same vertical position on the page.

Rotating objects

Select the object you wish to rotate from the List of Objects dialog, choose the Open Context Menu button and select Rotation. On the dialog that appears, enter the desired angle of rotation in degrees and choose OK to rotate the object.

Changing object line properties

Select the object you wish to edit from the List of Objects dialog, choose the Open Context Menu button and select Line Style. This opens a dialog from which you can set the line properties for the object, including the line pattern (solid or dashed) and thickness. The drop-down list for the line pattern describes the number of pixels of black + the number of pixels of white that make up the line. For example, 2+2 means that the line will have two pixels of black followed by two pixels of white, while 5+3 will have five pixels of black followed by three pixels of white (so that the line is a pattern of longer black lines with shorter white spaces in between). Once you select the line patter, choose the thickness of the line in pixels. Choose OK to apply your changes to the object and close the dialog.

Changing object fill properties

Select the object you wish to edit from the List of Objects dialog, choose the Open Context Menu button and select Fill Style. This opens a dialog from which you can set the fill properties, including selecting a fill texture, scaling the size of the fill tiles and rotating the texture within the object.

If you would like to add a fill texture to your object, select the Use Texture Fill radio button. Choose the Change Texture button to bring up a dialog containing a list of textures that can be used. Select a texture from the list of options and choose OK. Use the Tile Size in Pixels edit box to scale the texture larger or smaller. You can also rotate the texture using the Texture Rotation Angle edit box. When you are finished making changes, choose OK to apply the fill to your object.

Adding audio labels

Audio labels are a great way to add more information to a drawing without having to make it larger to accommodate more text or graphical information. The audio information is accessed by using the file in explore mode.  For more information on explore mode, please refer to the Using Explore Mode.

Audio labels can be added to any type of drawing object in TactileView, and to mammoth braille or raised print character labels. Audio labels may not be added to text labels, because text labels are automatically voiced by text-to-speech when the file is used in explore mode.

Adding an audio label to be voiced by text-to-speech

Select the object you wish to add an audio label to from the List of Objects dialog, choose the Open Context Menu button and choose Audio Style. This will launch an audio label dialog, the top section of which allows you to specify the text to be voiced by synthetic speech from one of several sources.

In the “Text or document in synthetic speech (TTS) section of the dialog, the default choice is the Self Defined Text radio button, which allows you to type the text you want voiced into the text field on the dialog. If you have text saved in a text file that you would like voiced instead, you can select the Text from Local File radio button, then choose the Browse button to browse to and select your text file. Once you have specified the text, you can check how the label will sound by selecting the Test Audio Label button. When you are finished making changes, choose the OK button to close the dialog and apply the audio label.

Attaching an existing sound file to an object

You can also attach an existing sound file to an object to have it played when the object is clicked while the file is in explore mode. To do this, select the object you wish to add an audio label to from the List of Objects dialog, choose the Open Context Menu button and choose Audio Style. This will launch an audio label dialog, the bottom section of which allows you to specify a sound file to play when the object is clicked in explore mode.

In the “Insert sound sample from” section of the dialog, the default choice is the Local File radio button, which is the one needed to attach a sound file to the object as a label. Select the Browse URL button, locate the sound file you would like to use on your computer and select it. The file path to the sound file will now appear in the text field below the sound file type selection radio buttons. You can check how the audio label will sound by selecting the Test Audio Label button. When you are finished making changes, choose the OK button to close the dialog and apply the audio label.

NOTE: If you have both a text-to-speech audio label and a sound file audio label attached to the same object, the text-to-speech will be voiced first and the sound file will play after it.

Recording an audio label from a microphone

Audio labels recorded from a microphone are played when the object is clicked with the mouse or touch screen while using the file in explore mode. Recorded labels are played after any text-to-speech labels are voiced.

Before recording, you will need to ensure that you have a microphone connected to your computer. When you have connected a microphone to your computer, you can record an audio label for an object by selecting the object from the List of Objects dialog, choosing the Open Context Menu button and selecting Record Microphone. An Audio Recording dialog appears, allowing you to select the

microphone from which you wish to record, the format in which to record the sound, the location in which to store the recording and the volume percentage at which to record. To begin recording, choose the Start Recording button. To stop recording, press enter. To play back your recording, choose the Play Recording button. If you wish to re-record your audio label, just repeat the recording process. Only the most recent recording will be attached as the audio label for the file.

NOTE: Each object may only have one text-to-speech audio label and one recorded or sound file audio label associated with it. If you record an audio label for an object, it will replace any existing sound file you may have associated with that object previously.

Editing an existing audio label

You may edit any type of audio label by repeating the steps used to create the audio label.

9.04 [bookmark: 9.04_Browsing_and_selecting_objects_(Tab][bookmark: _bookmark53][bookmark: _Toc205893303]Browsing and selecting objects (Tab or Shift+Tab)
All objects that have been placed in the design with one of the drawing tools are grouped in the objects list (Ctrl+M). From this list, the respective context menus can be opened to change the properties of the object.

You can select an object or text label in the design by choosing it from this list, then pressing 'OK'.

Cycle through text labels and objects with Tab or Shift+Tab

To conveniently cycle through the objects and text labels that are present in the design, use Tab (cycle forward) or Shift+Tab (cycle backwards). One by one, the objects and text labels will get the focus (will be selected). The name and position of the object or label will be announced.

This way you can cycle from top to bottom through the design. If any objects are horizontally aligned, the objects further to the left will come first.

Use Ctrl+K or the enter key to open the context menu if you wish to make any changes to the object.

9.05 [bookmark: 9.05_View_-_Context_menu_(Ctrl+K_or_Ente][bookmark: _bookmark54][bookmark: _Toc205893304]View - Context menu (Ctrl+K or Enter)
Any objects that were placed in the design can be edited later. Opening the context menu of a selected object or drawing tool gives access to all the properties that can be changed. 

View - Open context menu (Ctrl+K or Enter)

Once you have selected an object in the design, you can open the context menu by choosing 'Context menu' from the View menu. Alternatively, you can press Ctrl+K or the Enter key as a shortcut to open the context menu.

Open context menu via Object list (Ctrl+M)

The object list shows all object that are present in the design. Choose 'Open context menu' in this object list dialog. The respective context menu will open, in which you will find all options to edit the properties of the selected object.

9.06 [bookmark: 9.06_View_-_Show_properties_(Ctrl+J)][bookmark: _bookmark55][bookmark: _Toc205893305]View - Show properties (Ctrl+J)
When an object is selected in the design, it can be very useful for screen reader users to get a quick list of all the properties. To can select an object in your design, choose either 'Menu driven design' from the Drawing tools menu (Ctrl+L), or 'List of objects' from the View menu (Ctrl+M). In either list, select the object and press 'OK'. The object now has the selection. The properties list of the selected object can be opened by selecting 'Show properties' in the View menu, or by pressing Ctrl+J.

The list of properties include aspects such as size, position in the design, etc. Use the button 'Speak properties' to hear the properties in a spoken message. If you wish to make any changes to the object, choose 'Open context menu'.

9.07 [bookmark: 9.07_View_-_Play_audio_style_(Ctrl+I)][bookmark: _bookmark56][bookmark: _Toc205893306]View - Play audio style (Ctrl+I)
When the selected object has been provided with an audio style, it can be played using the shortcut Ctrl+I or by selecting 'Play audio style' from the View menu.

In the section 'Using audio styles' you can read more about the use of audio styles.

10.01 [bookmark: 10.01_Introduction_and_preparation_steps][bookmark: _bookmark57][bookmark: 10.05_Using_Explore_Mode_(ClickPad)][bookmark: _bookmark61][bookmark: _Toc205893307]Using Explore Mode 
Explore mode allows you to interact with a TactileView file the way a user will. For example, when you click a text label in a file while using explore mode, the text label will be voiced via text-to-speech instead of becoming selected so that you can edit it like it does in design mode. Similarly, the audio labels for drawing objects will play when the object is clicked, instead of the object being selected for editing.

Limited options for changing audio information in the file are available within explore mode, but otherwise files cannot be edited from this mode. If you would like to make changes to anything else in the file, you must switch back to design mode to do so.


Entering explore mode

In order to use a file in explore mode, you must first open it in TactileView, which defaults to design mode when a file is opened. Once you have a file open, explore mode can be activated in one of three ways: by selecting the Explore with Speech and Sound icon from the tool bar across the top of the screen, by selecting the Explore with Speech and Sound option from the View menu or by pressing CTRL+E.

Exploring a file

When you first open a file in explore mode, certain information about the file is automatically voiced. The name of the currently selected speech voice is spoken, as well as the title of the file. TactileView also tells you how many audio styles (audio labels) are in the file when you first enter explore mode.

You can explore the file by clicking different items in the file with the mouse. 

When you click on a text label, the text in the label is spoken via text-to-speech. When you click on an object with an audio label, the audio label is played. If the audio label contains both synthesized speech and a sound file, the synthesized speech will begin first and then the sound file will play. Clicking on a blank area or on an object other than a text label that does not have an audio label will cause TactileView to voice “empty.”

Changing an object’s audio label

If you discover an object that does not have an audio label and want to add one, you can right-click it and choose Change Audio Style for Object option from the context menu. This brings up the audio label properties dialog, which allows you to create an audio label the same way you would in design mode. For

more information on the options on this dialog, please refer to the Adding and Editing Audio Labels tutorial. When you are done making changes, choose the OK button to close the dialog and apply your audio label.

You can also edit existing audio labels for an object by right-clicking the object and choosing Change Audio Style for Object from the context menu to bring up the audio label properties dialog. Make any desired changes on this dialog, then choose the OK button to close the dialog and apply your changes to the audio label. Please note that at this time no audio labels are exported with the file. 

Setting the voice for text-to-speech

To select a different voice for synthesized speech in TactileView:
1. Right-click anywhere within your file.
2. From the context menu, select Audio Style.
3. Click on Speech Settings.
4. In the window that appears, choose your preferred voice from the dropdown list.
TactileView will immediately apply the new voice for all synthesized speech used in audio and text labels.

Exiting explore mode

When you wish to return to design mode, press ESC on the keyboard or right-click anywhere in the file and choose Quit Explore Mode in the context menu.

11.01 [bookmark: 11.01_Printing_with_a_braille_embosser][bookmark: _bookmark62][bookmark: _Toc205893308]Printing with a braille embosser
Before printing from TactileView, ensure that the appropriate driver for your embosser is installed on your computer.
Starting with Version 3, TactileView provides a direct option to download embosser drivers:
1. Open the Print Setup dialog from the Printfile menu.
2. Click Install Printer.
3. From the dropdown list, select the embosser you wish to install and click Next.
4. A link to the manufacturer’s driver download page will be provided—follow this link to install the correct driver.

Once you’ve confirmed the driver is installed, return to Print Setup via the Print file menu to complete your configuration.

From the Printer Name list, select your embosser. Next, select the paper size you want to emboss on, and choose the print orientation. Select the OK button to save your settings and close the dialog.

If you changed any of the options on the screen, it may affect how your document will print. Depending on the size of your design area and whether it was sized for the paper size you’re using, the file may not make full use of the available space on the paper, or the design may run over slightly onto a second page. Check how your document will print by selecting Print Preview from the Print menu. This will open a preview of how your document will print.

Across the top of the screen are several print preview buttons arranged in a tool bar just above the area that usually contains drawings. If the Next Page button is available, this means that your document is currently configured to print on more than one page. Use the Next Page button to switch the view to the next page that will be printed, or use the Two Pages button to display two pages of your file at a time. When in two page preview mode, the Two Pages button will change to a One Page button to allow you to switch back to one page preview mode. When you are finished previewing your file, choose the Close button to close the preview. If you need to adjust the design area to fit the paper size, please refer to the Changing Design Size and Orientation tutorial.

Once your document appears in the preview the way you want it to print, select Print from the Print menu or press CTRL+P to bring up the Print dialog. This is a standard Windows print dialog, which allows you to select which pages to print and how many copies you would like printed. Make the desired selections, then choose the OK button to close the dialog and print the file.

11.02 [bookmark: 11.02_Printing_on_swellpaper_(microcapsu][bookmark: _bookmark63][bookmark: _Toc205893309]Printing on swellpaper (microcapsule paper)
Swellpaper or microcapsule paper is a heat sensitive paper and contains chemical ingredients that will create volume wherever there is black ink printed.
Once the design has been printed with an ink jet printer, the paper has to go through a special oven. In this process, the paper will ‘swell’ wherever black ink was printed. Laser printers are not recommended for swellpaper, as damage might be caused if the heat of the laser printer causes the paper to swell.
Whereas braille embossers will use lines made up of individual braille dots, designs printed on swellpaper have more fluid, continuous lines that retain more detail.

Braille dot diameter and paper variances
Swellpaper produced by various companies have slightly different properties in terms of the required temperature and duration of the temperature exposure. It takes some experience to find the optimal settings for the particular paper that you are using.
Depending on the oven temperature, the braille dots might not raise enough or they will be raised too much so they are no longer distinguishable as individual dots. To compensate for this effect, the diameter of the dots can be adjusted by choosing 'Text label presentation on print' from the Settings menu and increasing or decreasing the size of braille dots.

Printing text combining normal font and braille
The normal font (visual characters) of braille labels can be printed in a lighter colour that will not raise. Make sure to select another colour than black in 'Text label presentation on print' to avoid the text being raised.

11.03 [bookmark: 11.03_Printing_multiple_designs;_booklet][bookmark: _bookmark64][bookmark: _Toc205893310]Printing multiple designs; booklet
TactileView includes a convenient tool that allows you to consecutively print multiple designs. This option can be accessed by choosing 'Print multiple designs' from the File menu.

Tip: a bound booklet can already signify the page orientation, so in some cases it may be beneficial to switch off the right-up marker for the document.

Preparing the print list as a TXT file

In a few steps, you can easily create a print list. You can choose between a direct selection of the printed files (1a) or preparing the print list in advance (1b).

1a. Multiple file selection

In the dialog that opens, you can select the files that you wish to include in your print list. Hold down Ctrl to add single designs to the selection, or hold Shift to add consecutive files. Once you have all the files selected, click 'Open'.

The next dialog allows you to save the file selection as a .txt print list. This list needs to be saved in the same folder that contains the selected designs. Enter a file name and click 'Save' to confirm. If you do not wish to use the print list again later on you can also skip by clicking 'Cancel'.

1b. Use a previously prepared print list (TXT file)

You can create a print list in advance with any text editor such as Word or Notepad, or select a print list that was created previously following the steps in 1a.

Each line in the print list must contain one file name, including the .bpx file extension. If the file is located in a subfolder, include this before the file name, followed by a forward slash. Make sure that all file names are correct, including any spaces or punctuation marks. Designs can be included multiple times if necessary. Your print list should look like this:

file name 1.bpx subfoldername/file name 2.bpx file name 3.bpx

Save your print list as a .txt file in the folder that contains the TactileView designs. In TactileView, select 'Print multiple designs' from the file menu, then choose 'Single selection: list with file names (*.txt)' and select your saved print list. Click 'Open' to continue.

2. Select print order

In the next dialog, you can select the order in which the designs should be printed. You can choose 'Original order' to print the designs in the order in which they are included in the print list. 'Reversed

original order' can be used to ensure the last file in the print list is on the bottom of the stack. 'Alphabetical order' and 'Reversed alphabetical order' can be especially useful is the file names already include ordered numbering.

Any files in the list that cannot be located will not be printed. The print job will continue with the next file name in the list.

Text and graphics combination

TactileView has the option to embed designs in a text document that was created with the Duxbury Braille Translator (DBT). When using DBT, you can use more advanced lay-out features such as page numbering, headers and footers, etc.

See: Inserting graphics in Duxbury Braille Translator

11.04 [bookmark: 11.04_Paper_size_vs._design_size][bookmark: _bookmark65][bookmark: _Toc205893311]Paper size vs. design size
The maximum paper size that printers generally can handle is A4, A3, US Letter or Tabloid. However, diagrams can be larger than the maximum paper size when an image needs to be enlarged to retain the level of detail in the original image. Multiple sheets can be placed in rows and or columns to allow for tactile diagrams of any large size. Note this does not apply when Monarch mode is activated. 

In your designs, the red paper border will indicate the size of the design and the number of sheets.
[image: Screenshot of a large map that is printed across two sheets of paper. ]

Figure 1. The map is printed across two sheets of paper side to side in order to include sufficient detail.

Be aware that resizing the design, changing the paper orientation or adding or removing space within the design may unintentionally cause it to extend beyond the size of one sheet of paper. Once more, the design will be printed on two sheets of paper, but the second page will only contain the right-up marker. The red borders will indicate this on screen. Use the purple markers along the sides of the design to make it fit whithin a single sheet of paper.


[image: ]

Figure 2. The white area of the design extends slightly beyond the red border marking the paper size.
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Step 1/4: Computer Registration
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Step 2/4: Printer setup

To produce the designs that you have created, you can either pint them on an ordinary printer using micro capsue paper (swellpaper) or

ona braile embosser.
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Step 3/4: Configuration

Ve strongly recommend you to take some time to check the various settings. An optimal configuration wil give you the best possibl user
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Step 4/4: External software

The functonaity of the TactieView software can be extended even further by incorporating third party software. This software might
aleady be installed on your computer, otherise we refer you to the suppier of the softnare.
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| List of Labels and Objects...

After selection of a label or object the corresponding context menu can be opened to edit the properties.

design size: [204.0, 285.0 mm] (1.0 x 1.0 pages), printable area: [204.0, 285.0 mm], paper size: [209.8, 296.9 mm]

List ordered in:
(© Object Number O Alias O Type (O Position

Selected Object Number Alias Type Position Size Angle  Extra
Title text label 1 6.3,63mm  Characters per line: 31 , characters: 5, size: 31.8 mm 0 degrees Braille table en-us-col
ab  textlabel 2 63.5,44.0 mm  Characters per line: 22, lines: 1, characters: 3, size: 25.4 mm 0 degrees Braille table en-us-col
square/rectangle 1 47, 81 mm  73x73 mm 0 degrees
Ellipse 78,86mm  93x93mm 0 degrees

Open Context Menu Undo Object(s) Selection Add Text Label or Object

Test Audio Style Sketch with MDA
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Monarch Mode Settings

(O Monarch Mode Active:

Export to PDF Settings.
Export Document ahways as One Page:
Export Large Document as Mtple Pages

Intial Document Size:

a1
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Enable independent printing of nk and braile inorder to printa design on an nk printer fist, follwed by the braile version on a braile
embosser. This way, indvidualcbjects, images and text labels can aso be printed i rk only o braile only. Both printers can be
confiured separately below. Make sure to use identical paper format for both printers.
{8 Enable Braile after Ink printing mode.
print setup for ik printer print setup forbraile embosser

(OPrintimages in braile only and text with both braile and ink

O Print everything using braile and ink

‘Advanced Settings Braile after ik calbration ok Cancel
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Braill after ink calibration

The margins and printable areas of the selected braile and ink pinters might differ ata
mechanicallevel. Tt s recomended to print the test page using both printers and then
folow the calibration wizard i order to ensure the ink and the braile align as much a5
posshle. Itis also posble to manualy adjust the settngs.

Current calbraton settings:
Braile margin eft: .00 (nch)
Braile mergin top: 0.25 (nch)
Braile mergin right: 0.00 (nch)
Braile margin bottom: 0.00 (inch)
Inkmargn left: 0.00 (inch)
Ink margi top: 0.00 (inch)
Ink to bralle ratio X: 1.00
Ink to brale ratio Y: 1,47
‘Saved it braile printer: ETC Julet 120 (Copy 1)
‘Saved with ik printer: EPSONC32664 (XP-6100 Series)

print test page About the test page.

Calibration wizard Manual adjustment
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Calibrate braill after ink [Wizard] 1/7

Wielcome to the calfration wizard, to sart offprin the test page using both brale and ink. If you have aiready
printed a test page make sure to Use the same settings as the ones you used to printit orignaly or print a new test

page with the selected settngs.

Current calbraton settings: Test page inink (shown n bue) and braile

‘Braille margin left: 0.00 (inch)

‘Braille margin top: 0.25 (inch).

Brlle margn it .00 (nc)

‘Braille margin bottom: 0.00 (inch)

Inkmrginjef: 0,00 (nch) e
Ink margin top: 0.00 (inch)

ok el raio Xt 100

ok o brlle o V: 147

‘Saved with braille printer: ETC Juliet 120 (Copy 1)

‘Saved with ink printer: EPSONC32664 (XP-6100 Series)

Liibiga]

O Use current settings.
O Use defauit all margins to zero settings

(O Use printer defauit settings

print test page About the test page.

Previous Next

[T

FRFFT

[
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